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NOTATION

The following is a list of the acronyms, initialisms, and abbreviations (including units of
measure) used in this document. Acronyms used only in tables or equations are defined in the
respective tables or equations.

ABBREVIATIONS

CEC Commission of the European Communities
DCF dose-equivalent conversion factor
DOE U.S. Department of Energy
EAF electric arc furnace
EPA U.S. Environmental Protection Agency
FGR Federal Guidance Report
IAEA International Atomic Energy Agency
ICRP International Commission on Radiological Protection
ISCORS Interagency Steering Committee on Radiation Standards
MEI maximally exposed individual
NORM naturally occurring radioactive material
NRC U.S. Nuclear Regulatory Commission
OECD Organization for Economic Cooperation and Development
SAIC Science Applications International Corporation

UNITS OF MEASURE

Bq becquerel(s)
cm centimeter(s)
cm2 square centimeter(s)
g gram(s)
g/cm3 gram(s) per cubic centimeter
g/m3 gram(s) per cubic meter
h hour(s)
in. inch(es)
K degree(s) Kelvin
kg kilogram(s)
km kilometer(s)

km2 square kilometer(s)
km/h kilometer(s) per hour
m meter(s)
m2 square meter(s)
m3 cubic meter(s)
MB megabyte(s)
mm millimeter(s)
pCi picocurie(s)
Sv sievert(s)
t metric ton(s)
yr year(s)
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RESRAD-RECYCLE: A COMPUTER MODEL FOR ANALYZING THE
RADIOLOGICAL DOSES AND RISKS RESULTING FROM THE RECYCLING

OF RADIOACTIVE SCRAP METAL AND THE REUSE OF SURFACE-
CONTAMINATED MATERIAL AND EQUIPMENT

by

J.-J. Cheng, B. Kassas, C. Yu, D. LePoire, J. Arnish,
E.S. Dovel, S.Y. Chen, W.A. Williams, A. Wallo, and H. Peterson

ABSTRACT

The RESRAD-RECYCLE computer code is a pathway analysis tool
designed to calculate potential radiation doses and risks resulting from the
recycling of radioactive scrap metal and the reuse of surface-contaminated
material and equipment. RESRAD-RECYCLE is a member of the RESRAD
family of codes developed by Argonne National Laboratory to assess dose and
risk from decontamination, decommissioning, and remediation activities.
RESRAD-RECYCLE applies the latest methodology and modeling parameters to
provide a comprehensive risk analysis of the entire material recycling process. For
modeling purposes, this process is divided into six steps: scrap delivery, scrap
smelting, ingot delivery, product fabrication, product distribution, and use of the
finished products. In addition, RESRAD-RECYCLE also considers reuse of the
contaminated material in its original form. RESRAD-RECYCLE addresses short-
term and lifetime risks for both workers and users of finished products and
incorporates representative steps and scenarios that are significant in the recycling
process. The code assesses individual and collective population risks for workers
and the public and facilitates the derivation of release limits and standards.
RESRAD-RECYCLE is a user-friendly, menu-driven, interactive code that can be
run on an IBM-compatible personal computer under a Windows™ environment.
The code accounts for decay and ingrowth of radionuclides, dilution of scrap
metal, radionuclide and mass partitioning factors during the smelting operations,
and the distribution of metal mass in the various consumer products, as well as the
varying densities and geometries of the radiation sources. The structure of the
code allows a complete material flow balance in terms of mass and radioactivity
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during the recycling process. Individual, collective, and cumulative committed
effective dose equivalents and risks are tabulated on the basis of the scenario,
pathway, and radionuclide. The code uses the most up-to-date data and
information from recent studies of metal recycling. The code also can perform
probabilistic analysis for estimating the statistical distribution of radiation doses
and risks that result from uncertainties of the parameters applied in the
calculations.

1  INTRODUCTION

1.1  RESRAD-RECYCLE AND THE RESRAD FAMILY OF CODES

RESRAD-RECYCLE is a member of the RESRAD family of computer codes developed
to assess doses and risks from decontamination, decommissioning, and remediation activities
involving radioactive and other hazardous materials. The RESRAD family consists of the
RESRAD code (Yu et al. 1993a) and the six subcodes shown in Figure 1.1. The RESRAD code
was designed to estimate potential radiation exposures from a radioactively contaminated site
and to derive soil cleanup criteria, whereas the RESRAD subcodes were developed to address
other specific contamination issues. For example, RESRAD-CHEM addresses chemically
contaminated sites and the corresponding chemical risks. These subcodes are currently in various
stages of development and are available for use in risk assessments or for testing and evaluation.

RESRAD-RECYCLE addresses the recycling and reuse of radioactively contaminated
materials, such as scrap metals and equipment. While this subcode focuses on the recycling
process and its associated radiation exposures, other members of the RESRAD family of codes
can be used for conducting a risk analysis of related issues. For example, the RESRAD code can
be used for evaluating the risks associated with the disposal of recycled materials, and RESRAD-
BUILD can be used for performing a detailed analysis of potential risks resulting from the use of
buildings constructed with recycled materials. Although RESRAD-RECYCLE implements
specific methodologies for the recycling process, the database of dose-equivalent conversion
factors (DCFs) and the mathematical models for external exposure are consistent with those used
by the other codes within the RESRAD family.
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FIGURE 1.1  The RESRAD Family of Codes
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1.2  THE RECYCLING ISSUE

The issue of assessing the risks associated with the recycling of radioactively
contaminated materials is complicated by the need to consider the many steps in the recycling
process that can lead to radiation exposure of various receptors. This document is not intended to
provide an in-depth discussion of the complex steps involved in the recycling process; rather, it
is intended to describe a computational tool that can be used for evaluating the potential risks
resulting from the recycling process. Detailed discussions of the steps involved in the recycling
process are provided in several studies, including those by Science Applications International
Corporation (SAIC 1994, 1998), S. Cohen and Associates (1995), Nieves et al. (1995), the
Organization for Economic Cooperation and Development (OECD 1994), the International
Atomic Energy Agency (IAEA 1992), Kennedy and Strenge (1992), the Commission of the
European Communities (CEC 1988), and O’Donnell et al. (1978).

Various degrees of restriction could be involved in the reuse of radioactively
contaminated materials. Such restrictions could determine the types of final products of these
contaminated materials and the potential receptors of radiation exposures. Figure 1.2 is a
simplified overview of the conceptual recycling process with different release restrictions. In
general, the reuse of radioactively contaminated materials can be classified into four categories:

• Direct reuse involves the reuse of contaminated materials and equipment in
their original forms. Therefore, the contaminated materials are not smelted.
Materials and equipment that can be reused directly typically include
machinery and measurement tools, office furniture, and decommissioned
buildings.

• Unrestricted reuse involves the recycling of contaminated materials and their
release to commercial smelters for production of such consumer products as
automobiles, frying pans, and beverage cans.

• Restricted reuse involves the release of contaminated materials to a
radiologically licensed smelter for manufacturing of specific products that
would minimize public exposure (e.g., manufacturing slag for use in road
pavement or steel for use in bridge construction). This category usually
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FIGURE 1.2  A Conceptual Diagram of the Recycling Process
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involves large quantities of materials contaminated with relatively short-lived
radionuclides that are reused as public products when the radioactivity in them
has decayed significantly. The public products manufactured with
contaminated materials of this category would not be released to the
commercial market until the end of the radionuclide lifetimes.

• Controlled reuse usually involves contaminated materials from the nuclear
industry and other regulated facilities. Materials from these facilities could be
contaminated with long-lived radionuclides that have the potential for
emitting high levels of radiation and causing a greater health concern;
therefore, reuse of these materials is restricted to avoid public access and
exposures. The recycling of these materials and other related issues have been
the focus of the U.S. Department of Energy (DOE) Recycle 2000 initiative
(Warren 1995).

1.3  EVALUATION OF EXISTING COMPUTER CODES

Several computer codes have been designed for assessing potential radiation doses that
result from the reuse of radioactively contaminated scrap metals; however, these codes do not
provide a comprehensive analysis of the recycling process. For example, CONDOS is limited to
uranium- and thorium-contaminated materials (O’Donnell et al. 1975); CONDOS-II is an
updated and expanded version of CONDOS and considers 46 radionuclides (O’Donnell et al.
1981). IMPACT-BRC is based on CONDOS and includes a disposal scenario (Oztunali and
Roles 1984). These codes can evaluate only one exposure scenario at a time. Moreover, they use
outdated DCFs and do not calculate health risks or analyze uncertainties.

The U.S. Environmental Protection Agency (EPA) and the U.S. Nuclear Regulatory
Commission (NRC) have recently developed spreadsheets and computer codes for evaluating the
recycling of contaminated materials (SAIC 1998; S. Cohen and Associates 1997). These
spreadsheets and computer codes are not designed for general public use and consequently lack
flexibility and a user-friendly interface.
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1.4  OBJECTIVES AND GENERAL FEATURES OF RESRAD-RECYCLE

RESRAD-RECYCLE is a computer tool designed to provide a comprehensive
assessment of radiation doses and risks associated with the recycling and reuse of radioactively
contaminated materials. It considers the significant and representative steps involved in the
recycling and manufacturing process and incorporates representative exposure scenarios for each
step. Both short-term (one year) and long-term (the lifetime of a specific product) risks to
recycling workers and users of the end products are calculated. The risks for individuals are
calculated, as well as those for collective populations. A ranking routine has been incorporated to
sort the exposure scenarios according to the magnitude of individual and collective exposures,
respectively. The results of RESRAD-RECYCLE can be compared with target radiation
protection limits, thereby facilitating the derivation of regulatory standards and limits for the
release and reuse of radioactively contaminated materials. The code is based on the latest
methodologies and incorporates parameters from current studies and publications.

RESRAD-RECYCLE is sufficiently flexible to allow modification of exposure
parameters for developing user-specified scenarios. It is also capable of performing probabilistic
analysis for investigating the statistical distributions of potential doses and risks. Its user-friendly
interface facilitates data entry, code execution, and results viewing. A comprehensive on-line
help capability is available to guide users through the code.

1.5  SCOPE OF RESRAD-RECYCLE

RESRAD-RECYCLE assesses potential radiation exposures from the entire recycling
process on the basis of the various reuse restrictions discussed in Section 1.2. Figure 1.3 shows
the main screen of the code, which consists of the major components of the code. For modeling
purposes, the recycling process is divided into six representative steps: (1) scrap delivery,
(2) scrap smelting, (3) ingot delivery, (4) product fabrication, (5) product distribution, and
(6) use of the finished products. For each of the first five steps, scenarios were developed to
consider potential exposures for the workers involved, such as material loaders, drivers,
processors, and casters. Exposure scenarios for use of the finished products include use of a
parking lot, rooms and offices, household appliances, automobiles, ships and boats, frying pans,
beverage cans, office furniture, home furniture, road pavement, public buildings, and a bridge. In
addition to scenarios considering exposures from the recycling process and use of the finished
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FIGURE 1.3  Scope of RESRAD-RECYCLE

products, scenarios considering exposures from direct reuse of such surface-contaminated
materials as machinery tools and decommissioned buildings are included. In addition to these
default scenarios, other scenarios can be created by selecting a default scenario and then
modifying the exposure parameters to reflect the exposure conditions of the specific scenario.

The RESRAD-RECYCLE code considers 54 radionuclides pertinent to the recycling
process for dose and risk assessment. Several exposure pathways — external radiation,
inhalation, and incidental ingestion — are considered.

RESRAD-RECYCLE accounts for decay and ingrowth of radionuclides, dilution of scrap
metal, partitioning of radionuclides during the melting process, and mass distribution of metal in
the various consumer products. Text reports tabulate individual, collective, and cumulative
effective dose equivalents and risks by scenario, pathway, and radionuclide. Graphic output
shows the calculation results in bar charts and pie charts, which facilitate visual comparisons of
doses and risks from different pathways and radionuclides.
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1.6  ORGANIZATION OF THIS DOCUMENT

Features of the RESRAD-RECYCLE code and its use are described in detail in this
document. Exposure scenarios included in the code for workers and users of finished products
are described in Section 2. Section 3 describes the methodology used in the code. A user’s guide
for installing and applying the various features of the code is provided in Section 4. Section 5
discusses benchmarking and validation of the RESRAD-RECYCLE code with other recent
studies. Section 6 lists the references cited in the report.

1.7  TECHNICAL SUPPORT

For technical support and assistance with regard to questions not addressed in this
document, contact:

Dr. Charley Yu
Environmental Assessment Division
Argonne National Laboratory
Argonne, Illinois 60439
Phone: (630) 252-5589
Fax: (630) 252-6090
Email: resrad@anl.gov
RESRAD website: www.ead.anl.gov/resrad

www.ead.anl.gov/resrad
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2  DESCRIPTION OF SCENARIOS

For dose assessment purposes, representative exposure scenarios were developed for each
of the six recycling process steps: (1) scrap delivery, (2) scrap smelting, (3) ingot delivery,
(4) product fabrication, (5) product distribution, and (6) use of the finished products. In general,
the scenarios are based on information from recent publications, including SAIC (1994, 1998),
Nieves et al. (1995), S. Cohen and Associates (1995), OECD (1994), IAEA (1992), Kennedy and
Strenge (1992), CEC (1988), and O’Donnell et al. (1978). Two general types of exposure
scenarios have been incorporated into RESRAD-RECYCLE: (1) worker scenarios for evaluating
the dose and risk to workers who process recycled materials and (2) end-use product scenarios
for evaluating the dose and risk to persons using or otherwise being exposed to products made
from recycled radioactive materials. The worker scenarios model potential exposures associated
with (1) the transport of radioactive scrap metal from the place of origin to the smelter (step 1,
scrap delivery), (2) the smelting process and manufacture of metal ingots for industrial products
(step 2, scrap smelting), (3) transport of metal ingots to product fabrication plants (step 3, ingot
delivery), (4) product fabrication (step 4, initial and final fabrications) and (5) product
distribution (step 5, product distribution). End-use product scenarios model the use of finished
products or facilities, including (1) consumer products, (2) public products (pavement, bridges,
and buildings), (3) controlled products (shielding blocks and radioactive waste containers), and
(4) surface-contaminated reuse products (tools and decontaminated buildings). In addition to the
worker and end-use product scenarios, potential radiation exposures of the public from the
transport of radioactive scrap metals are also considered and discussed in the transportation
scenario. A total of 41 scenarios are included in RESRAD-RECYCLE. Of these, 35 apply to
both steel and aluminum; 3 apply only to steel, and 3 apply only to aluminum. Table 2.1
summarizes the scenarios included in the code.

Exposure scenarios that can be modeled by RESRAD-RECYCLE are not restricted to the
representative default scenarios included in the code. New scenarios can be created by selecting
a default scenario, modifying the exposure parameters, and constructing a geometry for the
radiation sources that reflects the appropriate exposure conditions.
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TABLE 2.1  RESRAD-RECYCLE Scenarios Applicable to Steel
and Aluminum

Applicability to Metal

Scenario Description Steel Aluminum

Worker scenarios
Scrap delivery: scrap cutter Yes Yes
Scrap delivery: scrap loader Yes Yes
Scrap delivery: scrap truck driver Yes Yes
Scrap smelting: scrap processor Yes Yes
Scrap smelting: smelter yard worker Yes Yes
Scrap smelting: smelter loader Yes Yes
Scrap smelting: furnace operator Yes Yes
Scrap smelting: baghouse processor Yes Yes
Scrap smelting: refinery worker Yes Yes
Scrap smelting: ingot caster Yes Yes
Scrap smelting: small object caster Yes Yes
Scrap smelting: slag worker Yes Yes
Ingot delivery: ingot loader Yes Yes
Ingot delivery: ingot truck driver Yes Yes
Initial fabrication: storage yard worker Yes Yes
Initial fabrication: sheet maker Yes Yes
Initial fabrication: coil maker Yes Yes
Final fabrication: sheet handler Yes Yes
Final fabrication: coil handler Yes Yes
Product distribution: product loader Yes Yes
Product distribution: product truck driver Yes Yes
Product distribution: sheet assembler Yes Yes
Product distribution: warehouse worker Yes Yes

End-use product scenarios
Consumer product: parking lot Yes Yes
Consumer product: room/office and house siding Yes Yes
Consumer product: appliance Yes Yes
Consumer product: automobile Yes Yes
Consumer product: ship/boat No Yes
Consumer product: office furniture Yes Yes
Consumer product: home furniture Yes Yes
Consumer product: frying pan Yes Yes
Consumer product: beverage can No Yes
Public product: pavement Yes Yes
Public product: building with rebars Yes No
Public product: building with geodesic dome No Yes
Public product: bridge Yes Yes
Controlled product: shielding block Yes No
Controlled product: radwaste container Yes No

Reuse product scenarios
Reuse product: tool reuse Yes Yes
Reuse product: building reuse Yes Yes

Transportation scenario
Scrap transportation: public exposure Yes Yes
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2.1  WORKER SCENARIOS

The worker scenarios considered under each recycling step are described in the following
sections. Default values for the exposure duration and the number of individuals involved in
every step are provided. These values are based on processing 100 metric tons (t) of scrap metal
per year. Tables 2.2 and 2.3 summarize the modeling parameters of all worker scenarios for steel
and aluminum scrap, respectively.

2.1.1  Scrap Delivery Step

Scenarios for three different workers are included under the scrap delivery step: a scrap
cutter, a scrap loader, and a scrap truck driver. The default values for each scenario are specified
on the basis of processing 100 t of scrap metal. Because these operations occur before the metal
is melted, mass and radionuclide partitioning factors (see Section 3) are not applied in the scrap
delivery step. The radionuclide concentration of the scrap metal is used directly in the dose
calculation.

For steel scrap, an average density of 3.93 g/cm3 is assumed. For aluminum scrap, an
average density of 1.4 g/cm3 is assumed. A smaller density than that of a solid metal is used to
account for air voids and the bulky nature of the scrap. The individual scenarios included in this
step are discussed below. (Public exposure from the transport of scrap metal is discussed in
Section 2.6.)

2.1.1.1  Scrap Cutter Scenario

The scrap cutter scenario models a worker who prepares the scrap for delivery to the
smelter. This worker’s activities include shredding, cutting, smashing, chopping, bailing, and
banding the scrap metal.

It is estimated that 3 individuals would each have to work 12 hours to process 100 t of
steel scrap. The exposure pathways assumed for this scenario include external exposure,
ingestion and inhalation of airborne particulates from the cutting process, and incidental
ingestion of particulates that attach to the hands during the cutting process. The default for the
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source for the external exposure pathway is modeled as a 0.5-t half cylinder with a thickness of
90 cm, a radius of 30 cm, and a density of 3.93 g/cm3. The average distance from the source is
assumed to be 200 cm.

Aluminum scrap is not as dense (assumed to be 1.4 g/cm3) as steel scrap. Therefore, the
volume of aluminum scrap to be processed would be greater than that of steel scrap. It is
estimated that 3 workers would each have to work 12 hours to process 100 t of aluminum scrap.
In the default case, the scrap handled is modeled as a half cylinder with a thickness of 90 cm and
a radius of 50 cm. The exposure pathways and exposure distance considered are the same as
those for steel scrap.

2.1.1.2  Scrap Loader Scenario

The scrap loader scenario models the potential doses to a worker who loads the
radioactively contaminated scrap metal onto trucks for transport to the smelter. Standard
mechanical loading equipment would be used for this operation.

It is estimated that 2 individuals would each have to work 4 hours to load 100 t of scrap
steel. The exposure pathways evaluated for this scenario include external exposure, ingestion and
inhalation of airborne particulates, and ingestion of particulates attached to the hands. For the
external exposure pathway, the steel source is modeled as a 25-t half cylinder with a thickness of
253 cm, a radius of 127 cm, and a density of 3.93 g/cm3. The average distance from the source is
assumed to be 400 cm.

For aluminum scrap, the number of workers, exposure duration, exposure distance, and
exposure pathways considered in the default case are the same as those for steel scrap. The
radiation source is modeled as a half cylinder with a thickness of 253 cm, a radius of 213 cm,
and a density of 1.4 g/cm3.

2.1.1.3  Scrap Truck Driver Scenario

The scrap truck driver scenario models the potential doses to a worker who transports
contaminated scrap metal from the place of origin to the processing facility. It is estimated that
5 drivers would each incur an exposure duration of 4 hours to transport 100 t of steel scrap.
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Because a driver would not be directly in contact with the radioactive scrap metal, the ingestion
pathway is not included in this scenario. The inhalation pathway is not expected to be significant
because the driver would be inside the truck cab and presumably would not be exposed to dust
from the scrap metal. Thus, the only pathway considered in this scenario is external exposure.

For the external dose calculation, the source for steel is modeled as a 20-t half cylinder
with a thickness of 900 cm, a radius of 60 cm, and a density of 3.93 g/cm3. For aluminum scrap,
the radiation source is modeled as a 20-t half cylinder with a thickness of 900 cm, a radius of
101 cm, and a density of 1.4 g/cm3. The driver is assumed to be 200 cm from the source. For
conservative purposes, the shielding from the truck cab is not taken into account.

2.1.2  Scrap Smelting Step

Scenarios for nine different workers are included under the scrap smelting step: a scrap
processor, a smelter yard worker, a smelter loader, a furnace operator, a baghouse processor, a
refinery worker, an ingot caster, a small object caster, and a slag worker. The default values for
each scenario are specified on the basis of processing 100 t of scrap metal. Because these
operations occur inside the smelting facility, mass and radionuclide partitioning factors (see
Sections 3.4 and 3.5 for detailed discussions) are applied in the calculation of the external,
inhalation, and ingestion doses. The individual scenarios included in this step are discussed
below.

2.1.2.1  Scrap Processor Scenario

The scrap processor scenario models a worker who prepares the scrap for processing at
the smelter. This individual’s activities include shredding, cutting, smashing, chopping, bailing,
and banding the scrap metal. It is estimated that 3 individuals would each have to work 12 hours
to process 100 t of scrap metal. The exposure pathways considered for this scenario include
external exposure, ingestion, and inhalation of airborne particulates.

For steel scrap, the radiation source is modeled as a 0.5-t half cylinder with a thickness of
60 cm, a radius of 30 cm, and a density of 5.9 g/cm3. For aluminum scrap, the thickness of the
half cylinder is 60 cm, the radius is 51 cm, and the density is 2.03 g/cm3. The average distance of
the processor from the source is assumed to be 200 cm.
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2.1.2.2  Smelter Yard Worker Scenario

The smelter yard worker scenario models potential doses to an individual who works at
the storage yard at the smelting facility. It is estimated that 10 workers would each have to work
a total of 80 hours to process 100 t of scrap metal. The pathways evaluated for this scenario
include external exposure, inhalation, and ingestion. The inhalation and ingestion pathways are
considered because the worker would be in the vicinity of the smelting facility where radioactive
air particulates could be present.

For steel scrap, the radiation source is modeled as a 100-t half cylinder with a thickness
of 351 cm, a radius of 175 cm, and a density of 5.9 g/cm3. For aluminum scrap, the source is a
100-t half cylinder with a thickness of 351 cm, a radius of 298 cm, and a density of 2.03 g/cm3.
The yard worker is assumed to be 1,000 cm from the radiation source.

2.1.2.3  Smelter Loader Scenario

The smelter loader scenario models the potential doses to a crane operator who loads
scrap metal into the furnace. The pathways evaluated for this scenario include external exposure,
inhalation, and ingestion. For steel scrap, the furnace is assumed to have a capacity of 100 t; for
aluminum scrap, the capacity of the furnace is assumed to be 10 t. It is estimated that 5 workers
would each have to work a total of 4 hours to process 100 t of steel scrap. It is estimated that
5 workers would each have to work a total of 20 hours to process 100 t of aluminum scrap.

For steel scrap, the radiation source is modeled as a 50-t half cylinder with a thickness of
279 cm, a radius of 139 cm, and a density of 5.9 g/cm3. For aluminum scrap, the radiation source
is a 5-t half cylinder with a thickness of 200 cm, a radius of 88 cm, and a density of 2.03 g/cm3.
The loader is assumed to work at a distance of 400 cm from the radiation source.

2.1.2.4  Furnace Operator Scenario

The furnace operator scenario models the potential doses to an individual who operates
the furnace. The capacity of the furnace is assumed to be 100 t for steel and 10 t for aluminum. It
is estimated that 3 operators would each have to work a total of 5 hours to melt 100 t of steel
scrap. To process the same amount of aluminum scrap, it is estimated that 3 operators would
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each have to work 50 hours. The pathways evaluated for this scenario include external exposure,
inhalation, and ingestion.

For steel scrap, the furnace is modeled as a 100-t full cylinder with a thickness of 253 cm,
a radius of 127 cm, and a density of 7.86 g/cm3. For aluminum scrap, the furnace is modeled as a
10-t full cylinder with a thickness of 170 cm, a radius of 83 cm, and a density of 2.7 g/cm3. The
operator is assumed to work 300 cm from the source.

2.1.2.5  Baghouse Processor Scenario

The baghouse processor scenario models the potential doses to an individual who handles
the baghouse contents. The processor loads the baghouse contents into special dust bags. It is
assumed that the contents of the baghouse have been sprayed with water to reduce dust
inhalation before loading. The loaded dust bags are transported to a storage or processing area.
The number of dust bags to be processed is a function of furnace throughput and the mass
partitioning factor of the baghouse. The amount of dust collected in the baghouse can range from
0.2 to 2% of the throughput mass. Because of this mass partitioning during smelting, the
radionuclide concentration in the baghouse dust could be higher than that in the radioactive scrap
metal. The external exposure, inhalation, and ingestion pathways are included in the dose
assessment for this scenario.

The radiation source for steel is modeled as a 1-t full cylinder with a thickness of 100 cm,
a radius of 40 cm, and a density of 2.0 g/cm3. It is estimated that one processor would have to
spend a total of 1 hour processing dust bags generated by the smelting of 100 t of steel scrap. The
radiation source for aluminum is modeled as a 0.5-t full cylinder with a thickness of 100 cm, a
radius of 34 cm, and a density of 1.4 g/cm3. The baghouse processor is assumed to spend 3 hours
processing the contaminated dust bags. The exposure distance is assumed to be 200 cm.

2.1.2.6  Refinery Worker Scenario

Depending on quality requirements for the final products, the metal melt from the
smelting process could need further refinement. It is assumed that the refinement would not
result in substantial loss of the metal; therefore, additional mass and radionuclide partitioning
factors are not applied.



2-10

It is estimated that 3 workers would each have to work 5 hours to process 90 t of steel (a
mass partitioning factor of 90% to melt). The radiation source is modeled as a 90-t cylinder, with
a thickness of 228 cm, a radius of 127 cm, and a density of 7.86 g/cm3. The radiation source for
aluminum is modeled as a 10-t full cylinder with a thickness of 150 cm, a radius of 89 cm, and a
density of 2.7 g/cm3. It is estimated that 3 workers would each have to work 14 hours to process
a total of 70 t of aluminum (a mass partitioning factor of 70% to melt). The refinery worker is
assumed to work at a distance of 300 cm from the source.

2.1.2.7  Ingot Caster Scenario

The ingot caster scenario models potential doses to a worker casting metal ingots. The
external exposure, inhalation, and ingestion pathways are included in the dose assessment for
this scenario. For the external exposure calculation, the steel ingot is modeled as a 10-t full
cylinder with a thickness of 100 cm, a radius of 64 cm, and a density of 7.86 g/cm3. It is
estimated that two casters would spend 2.5 hours each casting steel ingots at a distance of
150 cm. Aluminum ingot is modeled as a 2-t full cylinder with a thickness of 100 cm, a radius of
48 cm, and a density of 2.7 g/cm3. Two workers would have to work a total of 17.5 hours each
casting aluminum ingots at a distance of 150 cm.

2.1.2.8  Small Object Caster Scenario

The small object caster scenario models the potential doses to a worker casting small
objects at the smelting facility for use in industrial and consumer products. The external
exposure, inhalation, and ingestion pathways are included in the dose assessment for this
scenario. The radiation source for steel is modeled as a 1-t full cylinder with a thickness of 1 cm,
a radius of 201 cm, and a density of 7.86 g/cm3. It is estimated that 2 casters would each have to
spend about 50 hours to process 90 t of steel. The radiation source for aluminum is modeled as a
0.3-t full cylinder with a thickness of 1 cm, a radius of 188 cm, and a density of 2.7 g/cm3. It is
estimated that 2 casters would each have to work 50 hours to cast 70 t of aluminum into small
objects. The caster is assumed to work at a distance of 100 cm from the source.
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2.1.2.9  Slag Worker Scenario

The slag worker scenario models the potential doses to a worker who uses standard
loading and unloading equipment to handle the slag product at the smelting facility. After it
cools, the slag is typically a glassy solid material. The amount of slag generated would depend
on the smelting process and the use of slag forming agents. The mass partitioning factor to slag
for steel is assumed to be 10% of the smelting throughput and 30% of the throughput for
aluminum because aluminum oxidizes much more easily than steel. Because of this mass
partitioning during smelting, the radionuclide concentration in the slag may be higher than that in
the scrap metal. The pathways evaluated for the slag worker include external exposure,
inhalation, and ingestion.

For steel, the slag handled is modeled as a 10-t half cylinder with a thickness of 45.5 cm,
a radius of 228 cm, and a density of 2.7 g/cm3. It is estimated that 1 worker would have to work
a total of 25 hours to process 10 t of slag from the smelting of 100 t of scrap steel. For aluminum,
the slag handled is modeled as a 6.4-t half cylinder with a thickness of 45 cm, a radius of
213 cm, and a density of 2.0 g/cm3. It is estimated that 1 worker would have to work 50 hours to
process 30 t of slag from the smelting of 100 t of scrap aluminum. The slag worker is assumed to
work at a distance of 150 cm from the source.

2.1.3  Ingot Delivery Step

Scenarios for two different workers are included under the ingot delivery step: a loader
and a truck driver for the delivery of cast ingots to a fabrication plant. The default values for
each scenario are specified on the basis of processing 100 t of scrap metal. Because these
operations occur outside the smelting facility after the smelting process, mass and radionuclide
partitioning factors (see Section 3) are applied in the dose calculation. The inhalation and
ingestion pathways are not considered in this step because an ingot is a solid, and radionuclide
releases to the air are not possible under normal delivery conditions. The only potential pathway
considered in this step is external exposure. The individual scenarios included in this step are
discussed below.
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2.1.3.1  Ingot Loader Scenario

The ingot loader scenario models the potential doses to a worker who loads the cast
ingots produced at the smelter for transport to a fabrication plant. It is estimated that 2 loaders
would each have to work 2 hours to handle the metal ingots produced from 100 t of radioactive
scrap metal.

For steel ingots, the external source is modeled as a 50-t half cylinder with a thickness of
100 cm, a radius of 201 cm, and a density of 7.86 g/cm3. For aluminum ingots, the external
source is modeled as a 50-t half cylinder with a thickness of 200 cm, a radius of 242 cm, and a
density of 2.7 g/cm3. The ingot loader is assumed to work at a distance of 400 cm from the
source.

2.1.3.2  Ingot Truck Driver Scenario

The truck driver scenario models the potential doses to a worker who drives a truck that
transports the cast ingots to a fabrication facility. It is estimated that 5 drivers would each have to
work an average of 5 hours to transport the metal ingots generated from 100 t of scrap metal.

For steel ingots, the radiation source is modeled as a 20-t cylinder with a thickness of
200 cm, a radius of 64 cm, and a density of 7.86 g/cm3. For aluminum ingots, the radiation
source is modeled as a 20-t full cylinder with a thickness of 230 cm, a radius of 100 cm, and a
density of 2.7 g/cm3. The driver is assumed to be located 200 cm from the source; shielding from
the truck cab is not considered in the dose calculations.

2.1.4  Initial Fabrication Step

Scenarios for three different workers are included under the initial fabrication step: a
storage yard worker, a sheet maker, and a coil maker. The default values for each scenario are
specified on the basis of processing 100 t of scrap metal. Because these operations occur in a
separate facility from the smelter and after the smelting process, mass and radionuclide
partitioning factors into ingot are applied in the dose calculation. The individual scenarios
included in this step are discussed below.



2-13

2.1.4.1  Storage Yard Worker Scenario

The storage yard worker scenario models the potential exposures to a worker who
processes the cast ingots at the storage yard of the fabrication plant. The only pathway evaluated
in this scenario is external exposure. It is estimated that 10 workers would each work a total of
40 hours to process the cast ingots from 100 t of scrap metal.

The external radiation source for steel is modeled as a 50-t half cylinder ingot with a
thickness of 100 cm, a radius of 201 cm, and a density of 7.86 g/cm3. The external radiation
source for aluminum is modeled as a 50-t half cylinder with a thickness of 100 cm, a radius of
343 cm, and a density of 2.7 g/cm3. The distance between the worker and the source is assumed
to be 1,000 cm.

2.1.4.2  Sheet Maker Scenario

The sheet maker scenario models the potential doses to an individual who fabricates
metal sheets from the recycled scrap metal. The pathways included in the dose assessment for
this scenario are external exposure, inhalation, and ingestion. The external radiation source for
steel is modeled as a 0.047-t half cylinder with a thickness of 0.2 cm, a radius of 138 cm, and a
density of 7.86 g/cm3. It is estimated that 15 sheet makers would each have to work 1 hour to
process the steel generated from 100 t of scrap metal. The external radiation source for aluminum
is modeled with the same geometry as for steel, but with a density of 2.7 g/cm3. It is estimated
that 15 sheet makers would each have to work 2 hours to process the aluminum generated from
100 t of scrap metal. The exposure distance from the sheet makers to the radiation source is
assumed to be 100 cm.

2.1.4.3  Coil Maker Scenario

The coil maker scenario models the potential doses to a worker who makes coils from the
metal sheets produced in the previous step. The external exposure, inhalation, and ingestion
pathways are included in the dose assessment for this scenario. The radiation source for steel is
modeled as a 10-t full cylinder with a thickness of 122 cm, a radius of 58 cm, and a density of
7.86 g/cm3. It is estimated that 1 coil maker would have to work 1 hour to process 100 t of scrap
metal. The radiation source for aluminum is modeled as a 5-t full cylinder with a thickness of
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122 cm, a radius of 70 cm, and a density of 2.7 g/cm3. It is estimated that 1 coil maker would
have to work 2 hours to process all the aluminum. The average distance between the coil maker
and the radiation source is assumed to be 150 cm.

2.1.5  Final Fabrication Step

Evaluation of the final fabrication step takes into account workers involved in
manufacturing end-use products from the metal sheets and coils made from the radioactive scrap
metal. Scenarios for two different workers are included under the final fabrication step: a sheet
handler and a coil handler. The default values for each scenario are specified on the basis of
processing 100 t of scrap. Because these operations occur in a facility that is separate from the
smelter and occur after the smelting process has been completed, mass and radionuclide
partitioning factors into ingot are applied in the dose calculations. The inhalation and ingestion
pathways are not a consideration, as the metal sheets and coils are solids. It is not possible under
normal operational conditions for radionuclides to be released into the air. However, if it is
decided to include the inhalation and ingestion pathways in the analysis, the ingot partitioning
factors would be applied to estimate the radionuclide concentrations in the ingested or inhaled
particles. The individual scenarios included in this step are discussed below.

2.1.5.1  Sheet Handler Scenario

The sheet handler scenario models the potential doses to an individual who handles metal
sheets made from radioactive scrap metal. For steel sheets, the external radiation source is
modeled as a 0.047-t half cylinder with a thickness of 0.2 cm, a radius of 138 cm, and a density
of 7.86 g/cm3. It is estimated that 20 sheet handlers would each have to work 1 hour to process
the steel sheets generated from 100 t of scrap metal. For aluminum sheets, the external radiation
source is modeled with the same geometry as for the steel sheets, but with a density of 2.7 g/cm3.
It is estimated that a total of 20 workers would each have to work 2 hours to process all of the
aluminum generated from 100 t of scrap metal. The distance between the sheet handler and the
radiation source is estimated to be 100 cm.
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2.1.5.2  Coil Handler Scenario

The coil handler scenario evaluates the potential doses to a worker who handles coils of
metal sheets in the fabrication step. For steel coils, the  radiation source is modeled as a 10-t full
cylinder with a thickness of 122 cm, a radius of 58 cm, and a density of 7.86 g/cm3. For
aluminum coils, the radiation source is modeled as a 5-t full cylinder with a thickness of 122 cm,
a radius of 70 cm, and a density of 2.7 g/cm3. The distance between the worker and the radiation
source is assumed to be 150 cm. It is estimated that 5 coil handlers would each have to work
80 hours to handle the coils from metal sheets processed from 100 t of scrap metal.

2.1.6  Product Distribution Step

The product distribution step considers the transport and distribution of final products,
such as metal sheets, made from the recycled metal at the fabrication facility. Scenarios for four
different workers are included under the product distribution step: a product loader, a product
truck driver, a sheet assembler, and a warehouse worker. The default values for each scenario are
specified on the basis of processing 100 t of scrap metal. Because these operations involve the
finished product, only the external exposure pathway is considered in the dose assessment. If it is
decided to include the inhalation and ingestion pathways, ingot mass and radionuclide
partitioning factors would be applied to estimate the radionuclide concentrations in the inhaled or
ingested particles. The individual scenarios included in this step are discussed below.

2.1.6.1  Product Loader Scenario

The product loader scenario models the potential doses to an individual who loads and
unloads trucks used for the distribution of final products. For steel products, the external
radiation source is modeled as a 50-t half cylinder with a thickness of 100 cm, a radius of
201 cm, and a density of 7.86 g/cm3. For aluminum products, the external radiation source is
modeled as a 50-t half cylinder with a thickness of 200 cm, a radius of 242 cm, and a density of
2.7 g/cm3. The distance between the product loader and the radiation source is assumed to be
400 cm from the source. It is estimated that for a throughput of 100 t of scrap metal, 2 loaders
would each have to work 20 hours.
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2.1.6.2  Product Truck Driver Scenario

The product truck driver scenario models the potential doses to a worker who transports
finished products for distribution. For steel products, the external radiation source is modeled as
a 20-t full cylinder with a thickness of 200 cm, a radius of 64 cm, and a density of 7.86 g/cm3.
For aluminum products, the radiation source is modeled as a 20-t full cylinder with a thickness of
230 cm, a radius of 100 cm, and a density of 2.7 g/cm3. The driver is assumed to be located
200 cm from the radiation source. It is estimated that for a 100-t throughput of scrap metal,
5 drivers would each have to work 8 hours.

2.1.6.3  Sheet Assembler Scenario

The sheet assembler scenario models the potential doses to an individual assembling
metal sheets into end-use products. For external dose calculations, the radiation source is
modeled as a 0.047-t half cylinder with a thickness of 0.2 cm, a radius of 138 cm, and a density
of 7.86 g/cm3 and 2.7 g/cm3 for steel and aluminum products, respectively. The worker is
assumed to be 100 cm from the radiation source. It is estimated that for a 100-t throughput of
scrap metal, 20 sheet assemblers would each have to work 20 hours.

2.1.6.4  Warehouse Worker Scenario

The warehouse worker scenario models the potential doses to a worker involved in
managing the warehouse inventory of consumer products made from recycled radioactive metal.
For steel, the external source is modeled as a 0.28-t half cylinder with a length of 1.2 cm, a
radius of 138 cm, and a density of 7.86 g/cm3. For aluminum, the external radiation source is
modeled with the same geometry as that of steel, but with a density of 2.7 g/cm3. It is estimated
that 5 workers would each have to work 2,000 hours in the warehouse. The warehouse worker is
assumed to be 600 cm from the radiation source.

2.2  END-USE PRODUCT SCENARIOS

This section describes the consumer end-use product scenarios considered in
RESRAD-RECYCLE. Default values for the number of people considered in the collective dose
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calculations are based on recycling 100 t of scrap metal. Tables 2.4 and 2.5 summarize the
default modeling parameters for all the end-use product scenarios for steel and aluminum,
respectively.

The amount of steel available for manufacturing consumer products from the recycling of
100 t of radioactive scrap metal is assumed to be 90 t (i.e., the ingot mass partitioning factor is
90%), and the amount of slag produced from the smelting operation is assumed to be 10 t
(i.e., the slag mass partitioning factor is 10%). The amount of aluminum available for
manufacturing consumer products from 100 t of scrap metal is assumed to be 70 t (i.e., the ingot
mass partitioning factor is 70%), and the amount of slag is assumed to be 30 t. The mass
partitioning factors are input variables in RESRAD-RECYCLE and are discussed in detail in
Section 3.5.

The finished metal produced from the recycling process would be distributed among and
used by various industries. Statistical data showing the distribution of steel and aluminum among
different industries are listed in Tables 2.6 and 2.7, respectively. However, to estimate the
maximum radiation doses from the use of end products in the default cases, 100% of the finished
metal is assumed to be used to manufacture one of the end products. The distribution of finished
metal is an input variable for each product scenario and, therefore, can be changed by the user to
conserve mass balance among the various products.

2.2.1  Parking Lot Scenario

This scenario models the use of slag produced from the smelting process in an asphalt
parking lot. The slag is assumed to be diluted with concrete by a factor of 100 (1:100 ratio). The
mixture of slag and concrete is assumed to have a density of 2.7 g/cm3.

If the slag mass partitioning factor is assumed to be 10%, as is the case for steel, and all
of the slag is used for constructing a parking lot, the total mass of the slag-concrete mixture
would be 1,000 t. On the basis of this assumption, when the scrap metal is steel, the parking lot is
modeled as a homogenous full cylinder with a radius of 3,400 cm and a thickness of 10 cm. The
average individual is assumed to spend 10 minutes a day in the parking lot, which yields an
annual exposure time of 62 hours. For the collective dose calculation, the number of exposed
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For steel, the size of the room is assumed to be 5 m × 5 m × 3 m. In the dose calculations,
each wall is modeled as a half cylinder with a thickness of 0.2 cm, a radius of 300 cm, and a
density of 7.86 g/cm3. The average individual is assumed to be located 100 cm from one wall,
400 cm from the opposite wall, and 250 cm from the two adjacent walls. The individual is
assumed to spend 8 hours per day in the room for a total of 2,000 hours (50 work weeks) per
year.

If 940 kg of steel is needed to construct one room, about 96 rooms could be built from
recycling 100 t of radioactive scrap metal, assuming that 100% of the finished steel is used in the
construction of the walls. Thus, for an average occupancy of four persons per room, the number
of exposed individuals for collective dose assessment is estimated to be 380.

For aluminum, the size of the house is assumed to be 12 m × 12 m × 6 m. Each side of
the house is modeled as a half cylinder with a thickness of 0.2 cm, a radius of 600 cm, and a
density of 2.7 g/cm3. The exposed individual is assumed to be located at the center line of the
nearest wall, with a distance of 100 cm from the wall. For the maximally exposed individual
(MEI), an exposure time of 7,300 hours per year (20 hours per day, 365 days per year) is
assumed. For the collective dose calculation, an average exposure time of 5,600 hours is
assumed. An estimated 1.5 t of aluminum would be required for siding a single house; therefore,
approximately 45 houses could be sided with the finished aluminum produced from recycling
100 t of scrap metal, assuming that all the finished aluminum is used for siding. On the basis of
the above assumption and the assumption that an average household has 4 members, a total of
180 persons could be exposed to radiation under this scenario.

2.2.3  Appliance Scenario

The appliance scenario models the use of recycled steel in manufacturing home
appliances. Three types of appliances were modeled: refrigerators, stoves, and dishwashers.
Because of its large size, the refrigerator represents the most conservative case (i.e., yields the
highest dose). The refrigerator is modeled as a half cylinder with a thickness of 0.1 cm, a radius
of 92 cm, and a density of 7.86 g/cm3. The external exposure is calculated at a distance of
100 cm from the source. The exposed individual is assumed to spend 2 hours per day near the
refrigerator for a total exposure time of 730 hours per year. For the collective dose calculation, it
is assumed that one person is exposed per appliance. The average mass of steel used in a
refrigerator is estimated to be 21 kg. If 100% of available recycled steel is used in manufacturing
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refrigerators, approximately 4,300 refrigerators could be manufactured from the recycling of
100 t of radioactive scrap metal. Therefore, the number of exposed individuals used in
calculating the collective dose is 4,300.

The home appliance modeled for aluminum is a heating radiator, which is represented by
a half cylinder with a thickness of 0.1 cm, a radius of 100 cm, and a density of 2.7 g/cm3. It is
assumed that an individual would spend 2 hours per day, 365 days per year, at a distance of
100 cm from the radiator. If 100% of the finished aluminum is used in manufacturing radiators, a
total of 16,510 radiators could be produced, resulting in 16,510 persons being exposed to
radiation.

2.2.4  Automobile Scenario

The automobile scenario models the use of recycled steel in the manufacturing of
automobile bodies. The automobile is modeled as 4 full cylinders with a 0.1-cm thickness, a
150-cm radius, and a density of 7.86 g/cm3. The exposed individual is assumed to be located
50 cm from the source. The exposure time for an average individual is assumed to be 2 hours per
day, thus yielding a total exposure time of 730 hours per year. If 100% of the available recycled
steel is used in manufacturing automobiles and if an average of 222 kg of steel is used for each
one, it is estimated that 400 automobiles could be manufactured from recycling 100 t of
radioactive scrap metal. Thus, on the basis of an average occupancy of 2 persons per automobile,
the number of exposed individuals used for the collective dose assessment is 800.

The amount of aluminum used in each automobile is less than that for steel, although it
has been increasing over the years. An average of 125 kg of aluminum per automobile is
assumed in the dose calculation. The radiation source is modeled as 4 half cylinders each with a
thickness of 0.1 cm, a radius of 190 cm, and a density of 2.7 g/cm3. The exposed individual is
assumed to sit inside the automobile at a distance of 50 cm from the sources. A total exposure
time of 730 hours is assumed. According to the estimation, the finished aluminum from recycling
100 t of scrap metal could be distributed into 560 automobiles. On the basis of the assumption
that an average occupancy per automobile is 2 persons, the number of exposed individuals would
be 1,120.
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2.2.5  Ship/Boat Scenario

The ship/boat scenario was developed specifically to model aluminum. The amount of
aluminum used to manufacture the body of a ship/boat is assumed to be 500 kg. The ship/boat
body is represented by 4 half cylinders each with a thickness of 0.2 cm, a radius of 380 cm, and a
density of 2.7 g/cm3. The exposed individual is assumed to be 100 cm above the bottom of the
ship/boat, and 100 cm from the closest wall of the ship/boat. The MEI is assumed to spend
160 hours per year sailing the ship/boat, while the average exposed individual is assumed to
spend 16 hours per year riding the ship/boat. If it is assumed that the capacity of the ship/boat is
20 persons, a total of 2,800 persons could possibly be exposed to radiation.

2.2.6  Office Furniture Scenario

This scenario models the use of recycled metal in the manufacturing of office furniture.
Three types of office furniture were considered for modeling this scenario: desks, bookcases, and
file cabinets. Calculations indicated that the desk would be the most conservative case (i.e., yield
the greatest dose) because of the close distance and long period of time that an average
individual could be exposed. The desk is modeled as a half cylinder with a 0.1-cm thickness, a
103-cm radius, and a density of 7.86 g/cm3 (for steel) or 2.7 g/cm3 (for aluminum). The external
exposure is assumed to be 15 cm from the source. The average individual is assumed to spend
8 hours per day at the desk, which yields a total exposure time of 2,000 hours per year. The
amount of steel used in making a desk is estimated to be approximately 13 kg; for aluminum, it
is estimated to be approximately 4.5 kg. If 100% of available recycled metal is used to
manufacture office furniture, it is estimated that 7,000 steel or 15,560 aluminum desks could be
produced from recycling 100 t of radioactive scrap metal. The number of individuals used for
calculating of the collective dose is 7,000 and 15,560 for steel and aluminum, respectively,
assuming that 1 person is exposed per desk.

2.2.7  Home Furniture Scenario

This scenario models the use of recycled metal in the manufacturing of home furniture
such as wire bedsprings. The home furniture is modeled as a half cylinder with a 0.1-cm
thickness, a 110-cm radius, and a density of 7.86 g/cm3 (for steel) or 2.7 g/cm3 (for aluminum).
The external exposure is calculated at 15 cm above the source. The average individual is
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estimated to be exposed for 10 hours per day, which yields a total exposure time of 3,650 hours
per year. About 15 kg of steel or 5.15 kg of aluminum is estimated to be used in each piece of
home furniture. About 6,000 pieces of furniture made with steel or 13,640 pieces of furniture
made with aluminum could be produced from recycling 100 t of radioactive scrap metal.
Assuming 1 person is exposed per piece of furniture, the total number of exposed individuals
used to calculate the collective dose is 6,000 for steel and 13,640 for aluminum.

2.2.8  Frying Pan Scenario

This scenario models the use of recycled metal in the manufacturing of frying pans for
household use. The pan is modeled as a full cylinder with a 0.4-cm thickness, a 15-cm radius,
and a density of 7.86 g/cm3 for a steel pan and 2.7 g/cm3 for an aluminum pan. The external
exposure is assumed to be 30 cm above the source. The average individual is assumed to be
exposed for 0.5 hour per day, which yields a total exposure time of 180 hours per year. The
amount of metal used in a pan is 2.2 kg for steel and 0.76 kg for aluminum. Assuming that 100%
of finished metal is used to make frying pans, it is estimated that approximately 41,000 steel and
91,700 aluminum pans could be produced. For collective dose calculations, the number of
exposed individuals is 41,000 for steel pans and 91,700 for aluminum pans, on the basis of the
assumption that 1 person is exposed per pan. The internal dose is included in this scenario by
considering the ingestion of corroded metal from the pan. The ingestion exposure is calculated
by using the estimated corrosion mass of frying pans. The default corrosion rate of frying pans is
assumed to be 0.13 mm/yr.

2.2.9  Beverage Can Scenario

The beverage can scenario was developed specifically for aluminum because aluminum
cans account for more than 90% of the beverage can industry. Although it is unlikely that the
recycled radioactive metal would be used for manufacturing beverage cans, this scenario is
included in the RESRAD-RECYCLE code so that the potential radiation exposure can be
compared with that from other scenarios. Aluminum is a lightweight metal, and if all the finished
aluminum were used to produce beverage cans, approximately 4,300,000 cans could be produced
from recycling 100 t of scrap metal. For dose calculations, the beverage can is modeled as a full
cylinder with a thickness of 0.03 cm, a radius of 8 cm, and a density of 2.7 g/cm3. It is assumed
that an individual would take 0.5 hour to consume one can of beverage and that the MEI would
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consume 60 cans of beverage in a year, which would yield a total exposure time of 30 hours. The
exposure distance assumed in the dose calculation is 15 cm.

2.3  PUBLIC PRODUCT SCENARIOS

Public product scenarios model the use of major products by the general public. These
products would require the use of a large amount of metal in one area for a long period of time.
Such usage might be an attractive approach for recycling materials contaminated with relatively
short-lived radionuclides such as cobalt-60. Four representative public products are modeled in
the code: pavement made from slag generated during smelting of radioactive scrap metal, a
building constructed with reinforcing bars made from recycled steel, a building constructed with
a geodesic dome made from recycled aluminum, and a bridge constructed of recycled metal.
Tables 2.4 and 2.5 give the modeling parameters for steel and aluminum, respectively, for the
public product scenarios.

2.3.1  Pavement Scenario

The pavement scenario models the use of slag from the smelting of radioactive scrap
metal in the construction of pavement. The slag is assumed to be diluted with concrete by a
factor of 100. The mixture of slag and concrete is assumed to have a density of 2.7 g/cm3.

If the slag mass partitioning factor is assumed to be 10% of the total scrap, as in the case
for steel, the estimated total mass of the slag-concrete mixture would be 1,000 t. Then, assuming
all of the slag is used to construct the pavement, it would cover an area 370 m long and 10 m
wide. For dose calculations, the pavement constructed with steel slag is modeled as a
homogenous full cylinder with a radius of 3,400 cm and a thickness of 10 cm. The external
exposure is calculated at 100 cm above the pavement. For collective dose calculations, it is
assumed that 470 cars per hour pass over the pavement, a frequency that is typical for rural areas
(Neuhauser and Kanipe 1993). Each car is assumed to have 2 passengers and to be traveling at
50 km/h for a total exposure duration of 0.0074 hour per year. The number of exposed
individuals is approximately 8,200,000 per year. For calculation of the dose to the MEI, an
exposure duration of  6 hours per year from driving on the pavement twice a day at a speed of
50 km/h is used.
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If the slag mass partitioning factor is assumed to be 30% of the total scrap, as is in the
case for aluminum, then the estimated slag-concrete mixture would be 3,000 t. On the basis of
the same assumption for steel, the pavement is modeled as a full cylinder with a radius of
5,900 cm and a thickness of 10 cm. The exposure duration and number of exposed individuals
are assumed to be the same as those used for steel.

2.3.2  Building with Rebars Scenario

This scenario was developed specifically for steel and considers the use of reinforcement
bars (rebars) manufactured from recycled steel in the construction of public buildings. Four walls
of a 500 cm × 500 cm × 300 cm room are assumed to be constructed with rebars placed 15 cm
deep inside concrete. Each wall is modeled as a half cylinder with a 30-cm radius, a 0.5-cm
thickness, and a steel density of 7.86 g/cm3. The average individual is assumed to be located
100 cm from one wall, 400 cm from the opposite wall, and 250 cm from the two adjacent walls.
The individual is assumed to spend 8 hours per day in the room for a total of 2,000 hours per
year (50 work weeks per year). If 2.2 t of steel is needed to construct 1 room, about 41 rooms
could be built from recycling 100 t of radioactive scrap metal. Thus, for an average occupancy of
four persons per room, the number of exposed individuals used for the collective dose
assessment would be 164 (4 × 41).

2.3.3  Building with Geodesic Dome Scenario

This scenario was developed specifically for aluminum and considers the construction of
a geodesic dome with recycled aluminum on the top of a public building (museum, exhibition
hall, etc.). The dome is modeled as a full cylinder with a radius of 5,000-cm radius, a 0.2-cm
thickness, and a density of 2.7 g/cm3. A 15-cm thick concrete shielding is assumed for the dose
calculation. Assuming that the building is open to the public 250 days a year, and an average of
1,500 people visit daily, a total of 375,000 people would visit the building annually. For the
collective dose calculation, each visit is assumed to last for 4 hours. For individual dose
calculations, the MEI is assumed to spend a total of 500 hours per year inside the public
building. It is assumed that the receptor is 500 cm from the radiation source.
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2.3.4  Bridge Scenario

This scenario models the use of recycled metal for the construction of support beams for
a bridge. The bridge is assumed to be 500 cm wide and 10,000 cm long, with a beam height of
500 cm. Each side of the bridge is modeled as a half cylinder with a 1.2-cm thickness, a
1,800-cm radius, and a density of 7.86 g/cm3 for steel or 2.7 g/cm3 for aluminum. The external
exposure is calculated at 100 cm from one side and 400 cm from the other side of the bridge. For
the collective dose calculation, it is assumed that 470 cars cross the bridge each hour, a typical
rural traffic frequency (Neuhauser and Kanipe 1993). Each car is assumed to have 2 passengers
and to be traveling at 50 km/h, for a total exposure duration of 0.002 hour per year. The number
of exposed individuals is approximately 8,200,000 per year for steel, because one bridge could
be built from recycling 100 t of radioactive scrap metal. For aluminum, the number of exposed
individuals is approximately 16,400,000 per year, because two bridges could be built from
recycling 100 t of scrap materials. For MEI dose calculations, the individual is assumed to be
exposed for 1 hour per year driving across the bridge twice a day at a speed of 50 km/h.

2.4  CONTROLLED PRODUCT SCENARIOS

Controlled products are items manufactured for use by the nuclear industry and,
therefore, are not released for use by the general public. Two representative scenarios are
considered: construction of a shielding block and a radioactive waste container made from
recycled metal. Because of its low density, aluminum is usually not used for radiation shielding.
Therefore, the controlled product scenarios are considered specifically for steel. Modeling
parameters for the controlled product scenarios for steel is shown in Table 2.4.

2.4.1  Shielding Block Scenario

This scenario models the use of recycled steel for producing shielding blocks for use in
the nuclear industry and at DOE facilities. A typical steel block in use at high-energy
accelerators has a mass of approximately 20 t and dimensions of 132 cm × 132 cm × 132 cm
(Scientific Ecology Group 1993). The shielding block is modeled as a half cylinder with a
thickness of 132 cm, a radius of 105 cm, and a steel density of 7.86 g/cm3. The external dose is
calculated at a distance of 100 cm from the radiation source for a duration of 1 hour per year.
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2.4.2  Radioactive Waste Container Scenario

This scenario models the use of recycled steel in the manufacture of radioactive waste
containers. A typical low-level radioactive waste container has dimensions of
214 cm × 100 cm × 114 cm (Moghissi et al. 1986). The container is modeled in this scenario as a
half cylinder with a thickness of 0.27 cm, a radius of 100 cm, and a steel density of 7.86 g/cm3.
The external exposure is calculated for a distance of 100 cm from the radiation source for a
duration of 1 hour per year.

2.5  REUSE PRODUCT SCENARIOS

Reuse product scenarios model the direct reuse of surface-contaminated material and
equipment. These items are used in their original forms; they do not undergo the smelting
process as scrap metal. Two representative scenarios are included in the code: tool reuse and
building reuse. Modeling parameters of the reuse product scenarios are shown in Tables 2.4 and
2.5 for steel and aluminum, respectively.

2.5.1  Tool Reuse Scenario

This scenario models the use of a small surface-contaminated tool. The tool is assumed to
have a total surface area of 1 m2. For the external dose calculation, the tool is modeled as a full
disk, with a 56-cm radius. The exposed individual is assumed to be located 60 cm from the tool
inside a 500 cm × 500 cm × 300 cm room and is assumed to spend 8 hours per day in that room,
for a total of 2,000 hours per year (50 work weeks per year). One person is assumed to be in the
room for the collective dose calculation. Inhalation and ingestion doses are included in the
assessment. A building ventilation rate of one room volume per hour is applied as a default.

2.5.2  Building Reuse Scenario

This scenario models the use of a surface-contaminated room. The room is assumed to be
500 cm × 500 cm × 300 cm. Each wall is modeled as a half disk with a 300-cm radius. The
exposed individual is assumed to be located 100 cm from one wall, 400 cm from the opposite
wall, and 250 cm from each of the two adjacent walls. The individual is assumed to spend
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8 hours per day in the room for a total of 2,000 hours per year (50 work weeks per year). For the
collective dose calculation, four people are assumed to be exposed in the room. Inhalation and
ingestion doses are included in the assessment. A building ventilation rate of one room volume
per hour is applied as a default.

2.6  TRANSPORTATION SCENARIO

This scenario models the potential radiation exposure of a member of the public that
resides along the routes traveled by a truck that transports radioactive scrap metal from the place
of origin to a smelter. The scenario is included under the scrap delivery step (Section 2.1.1). The
truck is assumed to be loaded with 20 t of scrap metal with a density of 3.93 g/cm3 for steel and
1.4 g/cm3 for aluminum. Shielding provided by the truck body is considered to be 0.2 cm thick.
The population dose is evaluated as a function of truck velocity, distance traveled, population
density, and number of shipments needed. The truck velocity, distance traveled, and the number
of shipments needed are used to calculate the exposure time. The population density along the
route is used to estimate the number of people exposed. The user can modify these variables as
needed. Five shipments would be required to deliver 100 t of radioactive scrap metal. The default
values used in the code are 3,861 people/km2 for population density (Neuhauser and Kanipe
1993), 80 km/h for truck velocity, and 100 km for distance traveled.

The capacity of a truck is generally limited by the weight of the loaded materials.
Because the densities of ingots and finished metal products are greater than that of scrap metal, it
is expected that radiation exposure to the public under the transportation scenarios for ingots and
finished products would be less than that for scrap metal, given the same transportation route,
population density, and transport velocity. Estimates of the radiation doses that result from the
transport of ingot and finished products can be performed by modifying the variables in the scrap
transport scenario.

2.7  OTHER SCENARIOS

In addition to the calculation of radiation doses and risks for workers and end-use product
scenarios, the RESRAD-RECYCLE code also generates data that can be used by other computer
codes to address specific issues not evaluated in the code, such as stack emissions from the
smelter, land disposal of slag and baghouse contents, and occupancy of a multicompartment
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building constructed of recycled metal. These issues and related dose assessments are described
below.

2.7.1  Stack Emissions from a Smelter

RESRAD-RECYCLE provides information on the atmospheric release of radionuclides
during smelting operations. This information is provided in a table included in the summary
report, which is generated after the dose calculations are completed. The release amount
accounts for mass and radionuclide partitioning during the smelting process and the efficiency of
the filters installed in the smelting facility. The atmospheric release amount can be used by an air
dispersion model such as CAP88PC (Parks 1997), RESRAD-OFFSITE, or GENII (Napier et al.
1988) to evaluate the potential radiation exposure of individuals working or living at a downwind
location from the release point.

2.7.2  Land Disposal of Slag and Baghouse Content

RESRAD-RECYCLE does not evaluate radiation exposure for land disposal scenarios.
However, the summary report generated by the code provides information such as the total mass
and radionuclide activities in the slag and baghouse. The RESRAD code can use this information
to estimate the potential radiation doses resulting from disposal of baghouse contents and slag.
Detailed information about the RESRAD code can be found in Yu et al. (1993a).

2.7.3  Occupancy of a Multicompartment Building

The RESRAD-RECYCLE code includes scenarios that model the reuse of
decontaminated buildings or the use of buildings constructed with finished products from
radioactive scrap metal. It implements a one-compartment model to estimate potential radiation
exposures. A sophisticated multicompartment model for use with various types of radiation
sources (point, line, area, and volume) and air exchange between compartments (and between
compartments and the outdoor environment) is implemented in the RESRAD-BUILD computer
code, a subcode of RESRAD. Detailed information about RESRAD-BUILD can be found in
Yu et al. (1994).
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3  METHODOLOGY

This section describes the methodology used in the RESRAD-RECYCLE code for
calculating potential doses and risks from the recycling of radioactive scrap metal and the use of
end-products. In general, the exposure scenarios developed, the pathways considered, and the
exposure parameters used are based on information from recent publications [O’Donnell et al.
(1978), CEC (1988), IAEA (1992), Kennedy and Strenge (1992), OECD (1994), S. Cohen and
Associates (1995, 1997), SAIC (1994, 1998), and Nieves et al. (1995)]. The external exposure
model implemented in the RESRAD-RECYCLE code is consistent with the one implemented in
the RESRAD code (Kamboj et al. 1998). The internal DCFs used in the internal dose
calculations are those in EPA Federal Guidance Report (FGR) No. 11 (Eckerman et al. 1988).

For assessment purposes, the recycling process is divided into six steps (scrap delivery,
scrap smelting, ingot delivery, product fabrication, product distribution, and use of the finished
products), as discussed in Section 2, and representative exposure scenarios are considered under
each step. Figure 3.1, a flowchart of the RESRAD-RECYCLE code, outlines the calculation
procedure.

3.1  SELECTION OF RADIONUCLIDES

The following selection criteria for radionuclides were established to identify (from a
comprehensive list of more than 200 radionuclides) the radionuclides pertinent to the recycling
process analysis:

• Radionuclides analyzed in previous recycling studies were retained.

• Radionuclides with half-lives of less than one year were excluded, except for
those expected to be prevalent in radioactive scrap metal, such as zinc-65 and
manganese-54.

• Naturally occurring radioactive materials (NORM), such as radium-226 and
radium-228, were included.
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FIGURE 3.1  Flowchart of the RESRAD-RECYCLE Computer Code (PCFLOW-L)
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FIGURE 3.1  (Cont.) (PCFLOW1-L)
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FIGURE 3.1  (Cont.) (PCFLOW2-L)
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FIGURE 3.1  (Cont.) (PCFLOW3-L)
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• Progeny radionuclides were included so that complete decay chains could be
analyzed in dose calculations.

• Radionuclides found in smelted metal that originated from decontamination
and decommissioning of nuclear facilities were included (Johnson 1993).

Table 3.1 lists the radionuclides included in the RESRAD-RECYCLE code and their related
properties.

3.2  INTERNAL DOSE CONVERSION FACTORS

The RESRAD-RECYCLE code calculates inhalation and ingestion doses with the latest
committed effective DCFs obtained from EPA FGR No. 11 (Eckerman et al. 1988). These DCFs
were developed on the basis of recommendations in International Commission on Radiological
Protection (ICRP) Publications 30 (1979–1988) and 48 (1986) for plutonium and related
elements. The internal DCFs used in the code are listed in Table 3.1.

3.3  DECAY AND INGROWTH OF RADIONUCLIDES

Radioactive decay and ingrowth of progeny radionuclides are accounted for in the
RESRAD-RECYCLE code. Initial decay of radioactivity before the start of the recycling process
or use of a product is calculated with the following equation:

 e C = C initialt
i,i

λ−
0  , (3.1)

where

Ci = concentration of radionuclide i in the source at the time of recycling
or use (Bq/g or pCi/g for volume contamination, Ci,v, and Bq/cm2 or
pCi/cm2 for surface contamination, Ci,s);
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TABLE 3.1  Half-Lives, Average Decay Factors over One Year,
and Ingestion and Inhalation Dose Conversion Factors for
Radionuclides Included in RESRAD-RECYCLE

Dose Conversion
Factorb (Sv/Bq)

Radionuclidea
Half-Life

(yr)
Decay Factor
over 1 Year Ingestion Inhalation

Ac-227+D 2.18E+01 9.84E-01 4.00E-06 1.82E-03
Ag-110m+D 6.84E-01 6.29E-01 2.92E-09 2.17E-08
Am-241 4.32E+02 9.99E-01 9.84E-07 1.20E-04
Am-243+D 7.38E+03 1.00E+00 9.81E-07 1.19E-04
Ca-41 1.40E+05 1.00E+00 3.44E-10 3.64E-10
Ce-144+D 7.78E-01 6.62E-01 5.70E-09 1.01E-07
Cl-36 3.01E+05 1.00E+00 8.18E-10 5.93E-09
Cm-243 2.85E+01 9.88E-01 6.79E-07 8.30E-05
Cm-244 1.81E+01 9.81E-01 5.45E-07 6.70E-05
Cm-245 8.50E+03 1.00E+00 1.01E-06 1.23E-04
Cm-246 4.73E+03 1.00E+00 1.00E-06 1.22E-04
Cm-247 1.56E+07 1.00E+00 9.24E-07 1.12E-04
Co-57 7.42E-01 6.50E-01 3.20E-10 2.45E-09
Co-60 5.27E+00 9.37E-01 7.28E-09 5.91E-08
Cs-134 2.06E+00 8.49E-01 1.98E-08 1.25E-08
Cs-135 2.30E+06 1.00E+00 1.91E-09 1.23E-09
Cs-137+D 3.00E+01 9.89E-01 1.35E-08 8.63E-09
Eu-152 1.33E+01 9.74E-01 1.75E-09 5.97E-08
Eu-154 8.80E+00 9.62E-01 2.58E-09 7.73E-08
Fe-55 2.70E+00 8.82E-01 1.64E-10 7.26E-10
Mn-54 8.56E-01 6.85E-01 7.48E-10 1.81E-09
Na-22 2.60E+00 8.78E-01 3.10E-09 2.07E-09
Nb-94 2.03E+04 1.00E+00 1.93E-09 1.12E-07
Ni-59 7.50E+04 1.00E+00 5.67E-11 7.31E-10
Ni-63 9.60E+01 9.96E-01 1.56E-10 1.70E-09
Np-237+D 2.14E+06 1.00E+00 1.20E-06 1.46E-04
Pa-231 3.28E+04 1.00E+00 2.86E-06 3.47E-04
Pb-210+D 2.23E+01 9.85E-01 1.96E-06 6.26E-06
Pm-147 2.62E+00 8.79E-01 2.83E-10 1.06E-08
Pu-238 8.77E+01 9.96E-01 8.65E-07 1.06E-04
Pu-239 2.41E+04 1.00E+00 9.56E-07 1.16E-04
Pu-240 6.54E+03 1.00E+00 9.56E-07 1.16E-04
Pu-241+D 1.44E+01 9.76E-01 1.85E-08 2.23E-06
Pu-242 3.76E+05 1.00E+00 9.08E-07 1.11E-04
Ra-226+D 1.60E+03 1.00E+00 3.59E-07 2.32E-06
Ra-228+D 5.75E+00 9.42E-01 3.88E-07 1.37E-06
Ru-106+D 1.01E+00 7.24E-01 7.40E-09 1.29E-07
Sb-125+D 2.77E+00 8.85E-01 7.59E-10 3.30E-09
Se-79 6.50E+04 1.00E+00 2.35E-09 2.66E-09
Sm-151 9.00E+01 9.96E-01 1.05E-10 8.10E-09
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TABLE 3.1  (Cont.)

Dose Conversion
Factorb (Sv/Bq)

Radionuclidea
Half-Life

(yr)
Decay Factor
over 1 Year Ingestion Inhalation

Sr-90+D 2.91E+01 9.88E-01 4.13E-08 3.54E-07
Tc-99 2.13E+05 1.00E+00 3.95E-10 2.25E-09
Th-229+D 7.34E+03 1.00E+00 1.09E-06 5.84E-04
Th-230 7.70E+04 1.00E+00 1.48E-07 8.80E-05
Th-232 1.41E+10 1.00E+00 7.38E-07 4.43E-04
U-232 7.20E+01 9.95E-01 3.54E-07 1.78E-04
U-233 1.59E+05 1.00E+00 7.81E-08 3.66E-05
U-234 2.45E+05 1.00E+00 7.66E-08 3.58E-05
U-235+D 7.04E+08 1.00E+00 7.21E-08 3.32E-05
U-236 2.34E+07 1.00E+00 7.26E-08 3.39E-05
U-238+D 4.47E+09 1.00E+00 7.27E-08 3.20E-05
Zn-65 6.68E-01 6.22E-01 3.90E-09 5.51E-09
Zr-93 1.53E+06 1.00E+00 4.48E-10 8.67E-08

a +D denotes that the contributions of decay radionuclides with half-
lives of six months or less are included in the DCFs.

b Source: Eckerman et al. (1988).

Ci,0 = concentration of radionuclide i in the scrap metal at the time of

measurement, i.e., the input concentration (Bq/g or pCi/g for volume
contamination and Bq/cm2 or pCi/cm2 for surface contamination);

λ = radionuclide decay constant (yr–1); and

tinitial = initial time for decay before recycling or use (yr).

A weighting factor (average decay factor) is used in the code to account for radioactive
decay over a one-year period and is also used to adjust the radionuclide concentrations at the
beginning of recycle or usage. This factor represents the average fraction of activity present over
one year and is calculated as follows:

( ) λ−= λ− /1 eF decay  , (3.2)
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where Fdecay is the radionuclide average decay factor over one year (unitless) and λ is defined

previously.

The average decay factors over one year for all radionuclides included in the code are
shown in Table 3.1.

Ingrowth of progeny concentrations is calculated by using the Bateman equation; their
dose contributions are included in the individual, collective, and cumulative doses for the parent
radionuclide.

The collective dose is defined in the RESRAD-RECYCLE code as the sum of doses
received by all exposed individuals over a one-year period.

The cumulative dose is defined as the collective dose received over the exposure
duration. For worker scenarios, the cumulative dose is the same as the collective dose because
the exposure duration is assumed to last for one year. For end-use product scenarios, the
cumulative dose is the collective dose received over the lifetime of the products. In the
cumulative dose calculation, the average concentration over the lifetime of the product is derived
by using the following equation:

product
t

t + t

t
 i,lifetime i, tdteCC

productinitial

initial

λ−∫= 0  , (3.3)

where

Ci, lifetime = average concentration of radionuclide i in the product over the

lifetime of the product (Bq/g or pCi/g for volume contamination and
Bq/cm2 or pCi/cm2 for surface contamination) and

tproduct = lifetime of the product (yr).

This average concentration over the product lifetime is evaluated in RESRAD-
RECYCLE by using the trapezoidal rule of integration with 1,000 intervals.
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3.4  RADIONUCLIDE PARTITIONING FACTORS

The smelting process generally results in three types of by-products: (1) ingot, (2) slag,
and (3) dust. During melting operations, the radionuclides present in scrap metal distribute
among these three by-products. Radionuclides with low boiling points, such as cesium, typically
concentrate in the dust; those that oxidize easily tend to concentrate in slag.  The distribution of
radionuclides among the three by-products has not been extensively studied, and so far, almost
all of the studies focus on steel. Data available in the literature also vary significantly. The
distribution generally depends on the chemical properties of the radionuclides, the metallurgical
composition of the scrap metal, the slag-forming substances added to the melt, the melting
temperature, and the melting method.

Because of the considerable uncertainty in the radionuclide distribution, conservative
values have been estimated; in many cases, the sum exceeds 100%. Tables 3.2 and 3.3 give the
default radionuclide partitioning factors used in RESRAD-RECYCLE for steel and aluminum,
respectively. The partitioning factors for steel are based on a review of recent available data and
literature [Chapuis et al. (1987), Elert and Wiborgh (1992), IAEA (1992), Hertzler et al. (1993),
Johnson (1993), OECD (1994), S. Cohen and Associates (1995), Nieves et al. (1995), Otis
(1995)] and the authors’ best engineering judgment. The partitioning factors for aluminum are
based on thermodynamic considerations in the formation of metal oxides, the furnace operating
temperature of 1,000 K, the boiling points of metals and metal oxides, and the authors’ best
engineering judgment. RESRAD-RECYCLE users are encouraged to use available data pertinent
to the specific melting process under consideration.

3.5  MASS PARTITIONING FACTORS

The term mass partitioning factor refers to the fraction of throughput mass of the
smelting process that gets into the smelting by-product. Ingot is the main by-product of the
smelting process; depending on the source of the scrap, its mass can range from 40 to more than
90% of the throughput. The mass partitioning to the slag is affected by the mass partitioning to
the ingot and can account for more than 10% of the throughput. Dust and off-gas generated by
the furnace are collected in the baghouse. Some of the baghouse contents may be released to the
atmosphere through a stack. The amount of radionuclides released from the stack depends on the
efficiency of the filters at the facility and the volatility of the radionuclides. In general, gaseous
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TABLE 3.2  Radionuclide Partitioning Factors
Used in RESRAD-RECYCLE for Steel

Partitioning Factor (%)

Radionuclide Ingot
Baghouse
Contents Slag

Ac-227 1 2 97
Ag-110m 0 100 0
Am-241 1 2 97
Am-243 1 2 97
Ca-41 0 10 90
Ce-144 1 1 98
Cl-36a 0 10 0
Cm-243 1 2 97
Cm-244 1 2 97
Cm-245 1 2 97
Cm-246 1 2 97
Cm-247 1 2 97
Co-57 100 1 1
Co-60 100 1 1
Cs-134 1 97 2
Cs-135 1 97 2
Cs-137 1 97 2
Eu-152 20 0.5 80
Eu-154 20 0.5 80
Fe-55 100 1 1
Mn-54 100 1 1
Na-22 0 80 20
Nb-94 2 1 98
Ni-59 100 1 1
Ni-63 100 1 1
Np-237 1 2 97
Pa-231 1 2 97
Pb-210b 0.6 0 0
Pm-147 2 0 98
Pu-238 1 2 97
Pu-239 1 2 97
Pu-240 1 2 97
Pu-241 1 2 97
Pu-242 1 2 97
Ra-226 1 2 97
Ru-106 0 0 100
Sb-125 5 0 95
Se-79 0 80 20
Sm-151 2 0 98
Sr-90 20 10 80
Tc-99 10 100 10
Th-228 0 0 100
Th-229 0 0 100
Th-230 0 0 100
Th-232 0 0 100
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TABLE 3.2  (Cont.)

Partitioning Factor (%)

Radionuclide Ingot
Baghouse
Contents Slag

U-232 1 2 97
U-233 1 2 97
U-234 1 2 97
U-235 1 2 97
U-236 1 2 97
U-238 1 2 97
Zn-65 1 100 1
Zr-93 2 0 98

a 90% of Cl-36 is assumed to be released through  a
stack.

b 99.4% of Pb-210 is assumed to partition to the
refractory (Johnson 1993).

Sources: Chapuis et al. (1987); Elert and Wiborgh
(1992); IAEA (1992); Hertzler et al. (1993); Johnson
(1993); OECD (1994); S. Cohen and Associates
(1995); Nieves et al. (1995); Otis (1995).

radionuclides can be released through the stack completely. Off-gas and dust generated during
the smelting operation can contaminate the entire smelting facility. Table 3.4 gives the default
mass partitioning factors used in RESRAD-RECYCLE. Mass partitioning of the throughput
varies from furnace to furnace; thus, users of the RESRAD-RECYCLE code are encouraged to
use specific data pertaining to the furnace under consideration.

Because of partitioning of radionuclides and distribution of mass in the by-products, the
concentrations of some radionuclides can be much higher in one of the by-products than the
original concentrations in the scrap metal. The radionuclide concentrations in the various
smelting by-products are derived as follows:

 --   MPF/WRPF  C = C productbyscrapiscrapi,productbyi, ××  , (3.4)
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TABLE 3.3  Radionuclide Partitioning Factors
Used in RESRAD-RECYCLE for Aluminuma

Partitioning Factor (%)

Radionuclide Ingot Baghouse Contents Slag

Ac-227 100 1 10
Ag-110m 100 1 1
Am-241 5 1 100
Am-243 5 1 100
Ca-41 100 1 10
Ce-144 5 1 100
Cl-36b 0 10 0
Cm-243 5 2 100
Cm-244 5 1 100
Cm-245 5 1 100
Cm-246 5 1 100
Cm-247 5 1 100
Co-57 100 1 10
Co-60 100 1 10
Cs-134 5 100 1
Cs-135 5 100 1
Cs-137 5 100 1
Eu-152 5 1 100
Eu-154 5 1 100
Fe-55 100 1 10
Mn-54 100 1 10
Na-22 100 5 10
Nb-94 100 1 10
Ni-59 100 1 10
Ni-63 100 1 10
Np-237 100 1 10
Pa-231 100 1 10
Pb-210 100 1 10
Pm-147 5 1 10
Pu-238 10 1 100
Pu-239 10 1 100
Pu-240 10 1 100
Pu-241 10 1 100
Pu-242 10 1 100
Ra-226 10 1 100
Ra-228 10 1 100
Ru-106 100 1 10
Sb-125 100 1 10
Se-79 5 100 1
Sm-151 5 1 100
Sr-90 100 1 10
Tc-99 100 1 10
Th-228 5 1 100
Th-229 5 1 100
Th-230 5 1 100
Th-232 5 1 100
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TABLE 3.3  (Cont.)

Partitioning Factor (%)

Radionuclide Ingot Baghouse Contents Slag

U-232 10 1 100
U-233 10 1 100
U-234 10 1 100
U-235 10 1 100
U-236 10 1 100
U-238 10 1 100
Zn-65 100 5 10
Zr-93 5 1 100

a The partitioning factors were developed by comparing
the oxidization potential of the elements with that of
aluminum, and the boiling temperature of the element
and its oxides with the assumed furnace operation
temperature of 1,000 K. For conservative purposes, a
sum of greater than 100% was used.

b 90% of Cl-36 is assumed to be released through a
stack.

TABLE 3.4  Default Mass Partitioning Factors
in RESRAD-RECYCLE

By-Product Range Default

Percentage for Steel
   Ingot 90–99 90
   Slag   1–10 10
   Baghousea 0.2–2    1

Percentage for Aluminum
   Ingot – 70
   Slag – 30
   Baghouse –   1

a 0.003 to 0.06% released to the atmosphere through a
stack.

Sources: CEC (1988); Sappok (1989); Elert and
Wiborgh (1992); IAEA (1992); SAIC (1994); S. Cohen
and Associates (1995).
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where

Ci,by-product = concentration of radionuclide i in the by-product (ingot,
slag, or  baghouse) (Bq/g or pCi/g);

Ci,scrap = concentration of radionuclide i in scrap (Bq/g or pCi/g);

RPFi = radionuclide i partitioning factor (unitless);

Wscrap = dilution factor of scrap metal to account for fraction of
contaminated scrap metal to the total amount of scrap metal
fed to the smelter (unitless); and

MPFby-product = mass partitioning factor of the by-product (unitless).

3.6  THROUGHPUT CONSIDERATIONS

The amount of radioactive scrap metal that is recycled (throughput) affects the exposure
duration for workers and the number of workers involved in each step of the recycling process.
Moreover, the number of exposed individuals in the end-use product scenarios is also affected.
RESRAD-RECYCLE takes into account the influence of throughput on radiation exposure for
the various worker and end-use product scenarios.

For worker scenarios, the collective exposure duration is assumed to vary linearly with
the amount of throughput; by default, the number of workers is fixed and the exposure duration
of each worker is adjusted linearly. The limit on the exposure duration for the individual worker
is assumed to be 2,000 hours per year. If the exposure duration is greater than 2,000 hours per
year, a value of 2,000 hours per year is used, and the code increases the required number of
workers accordingly.

For the transportation scenarios considered in the scrap delivery and product delivery
steps, the number of trucks, or the number of drivers, is assumed to be fixed. The code then
linearly adjusts the exposure duration to reflect the change in the throughput mass.
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For end-use product scenarios, the adjustment to reflect changes in the throughput mass is
limited to the number of exposed individuals. The exposure duration in these scenarios is related
to the use of the products and, therefore, is not adjusted. RESRAD-RECYCLE assumes that the
result of recycling of more scrap is the generation of more products. Therefore, it adjusts the
number of exposed individuals linearly with the throughput mass. Scenarios pertinent to the
reuse of surface-contaminated material and equipment are not affected by the throughput of
scrap metal, because the material and equipment are reused directly and do not involve the
smelting of scrap metal.

3.7  VOLUME CONTAMINATION METHODOLOGY

Radiation doses assessed for scenarios that model volume contamination of scrap metal
include contributions from the inhalation, ingestion, and external exposure pathways.
Calculations for these pathways are described below.

3.7.1  Inhalation Pathway

The radiation dose from the inhalation of airborne radioactive particulates generated from
volume-contaminated metal is calculated as follows:   

WFDCF  ED  AD  IRCCEDE vi decay,iinhviiinh ××××××= ,,, (3.5)

,/ MPFRFPFRPFi ×××

where

CEDEinh,i = committed effective dose equivalent from inhalation of
radionuclide i (Sv or rem);

Ci,v = concentration of radionuclide i in the volume source (Bq/g or
pCi/g);

IR = inhalation rate (m3/h);
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AD = airborne-dust-loading factor (g/m3);

ED = exposure duration (h);

DCFinh,i = inhalation DCF for radionuclide i (Sv/Bq or rem/pCi);

Fdecay,i = radionuclide i average decay factor over one year (unitless);

Wv = dilution factor to account for dilution of contaminated metal with
clean material in the source (unitless);

PF = respiratory protection factor (unitless); and

RF = respirable fraction (unitless).

The concentration of radionuclide i in the volume source, Ci,v, can be that in the scrap
metal, Ci,scrap, or that in one of the smelting by-products (ingot, baghouse, or slag), Ci,by-product,

depending on the material that the worker handles or the user uses, or the material from which
dust particles are assumed to originate. Source materials considered in the dose calculations are
listed in Tables 2.2–2.5.

A critical parameter in determining the radiation exposure from inhalation is the
concentration of respirable dust in the air. This parameter depends on many factors, including
ventilation rate, activities that create dust suspension, size distribution of dust particles, and the
amount of material being handled during the activities. Because little information is available
about the amount of respirable dust in air, this parameter is estimated by using an airborne-dust-
loading factor and a respirable-fraction factor. The airborne-dust-loading factor, that is, airborne
particulate concentration, generally ranges from 5.0 × 10-5 g/m3 for a residential scenario
(Kennedy and Strenge 1992) to 1.8 × 10-3 g/m3 for a coal mining scenario (Oztunali et al. 1981).
A value of 1.0 × 10-3 g/m3 is used in RESRAD-RECYCLE as an upper-bound value for some of
the worker scenarios. For scenarios that have less potential for creating dust suspension, a
fraction of the upper-bound value is used as a default. This default value is consistent with those
used by the IAEA (1992). The default value used for the respirable fraction is 0.1, whereas that
for the inhalation rate is 1.2 m3/h (ICRP 1975). For workers, a respiratory protection factor is
used to account for the efficiency of the respiratory mask. For conservation, the default
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respiratory protection factor is 1.0 (i.e., no respirator is assumed). Discussion of the inhalation
rate and dust loading factor can be found in the data collection handbook for the RESRAD code
(Yu et al. 1993b).

3.7.2  Ingestion Pathway

The ingestion dose can be acquired by two exposure routes: (1) through inhalation of
airborne particulates larger than the respirable size and (2) through incidental ingestion of dust
particles deposited on the hands. The first route accounts for the dust particles being inhaled
through the nostrils and gaining access to the gastrointestinal tract. The incidental ingestion dose
from volume contamination is based on a mass ingestion rate. The ingestion dose is evaluated as
follows:

( )

,/

/1

,

,

,

MPFRPFWFDCF

EDIGCMPFRFPF RPFW
 

FDCFEDADIRC = CEDE

ivi decay,iing

vviiv

i decay,iing vi,iing,

××××

××+−××××

×××××

(3.6)

where

DCFing,i = ingestion DCF for radionuclide i (Sv/Bq or rem/pCi) and

IGv = incidental ingestion rate for volume contamination (g/h).

The concentration of radionuclide i in the volume source, Ci,v, is the same as that used for
the inhalation pathway. It varies among different scenarios and can be either Ci,scrap or
Ci,by-product. The source materials considered in the dose calculations are listed in Tables 2.2–2.5
for different scenarios and metals.

An incidental ingestion rate of 0.00625 g/h is used as a default value for the worker
scenarios for which incidental ingestion is considered.. This ingestion rate is recommended by
the EPA for adults in an occupational setting (EPA 1991). For the frying-pan scenario, the
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ingestion rate is derived from the size of the frying pan and the input corrosion rate of the metal.
RESRAD-RECYCLE uses a default value of 0.013 cm/yr for the corrosion rate (IAEA 1992). It
is assumed that 50% of the corroded material would be ingested by the user of the frying pan.
The ingestion rate for the frying-pan scenario is calculated as follows:

  760,85.0 /CRAIG panpan ×ρ××=  , (3.7)

where

IGpan = ingestion rate for the frying-pan scenario (g/h);

Apan = surface area of the frying pan (cm2);

CR = corrosion rate of metal (cm/yr);

ρ = density of frying-pan material (g/cm3);

8,760 = conversion factor (h/yr); and

0.5 = 50% of the corroded material is ingested.

3.7.3  External Pathway

Each contaminated volume contributes to the external exposure. In RESRAD-
RECYCLE, multiple contaminated volumes are considered for the various sides of a
contamination source. For example, in the automobile scenario for public products, a radiation
source with four contaminated sides is considered in the default case. Each contaminated side
can be modeled as either a full or a half cylinder. Like radiation doses calculated for the
inhalation and ingestion pathways, the radiation dose calculated for the external pathway is
obtained by using external DCFs, which are calculated for each contaminated volume. The DCFs
depend on the material in the radiation source, size of the radiation source (i.e., radius and
thickness), and distance (i.e., parallel and perpendicular) between the receptor and the
contaminated volume being considered. Figure 3.2 shows the relative position between the
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FIGURE 3.2  Illustration of the Relative Position between the Volume Source
and the Receptor

contaminated volume and the receptor considered in the RESRAD-RECYCLE code. In addition
to source geometry, material characteristics, and exposure distance, RESRAD-RECYCLE also
takes into account the potential attenuation of the radiation dose caused by shielding materials.
The user can specify the type of shielding material and its density and thickness for consideration
when the external dose is calculated.

The methodology used in RESRAD-RECYCLE for calculating external DCFs is the
same as that used in RESRAD; its development is based on the latest EPA external DCFs
(Eckerman and Ryman 1993). A detailed discussion of the methodology for calculating external
DCFs is provided in Kamboj et al. (1998).

The external dose incurred by the receptor is calculated with the following equation:

( )

,

,,,

MPF/RPFWF

DCFEDCEDE

ivi decay,

nside nsideiextvi,iext

×××

××= ∑
(3.8)

where

EDEext,i = effective dose equivalent from external exposure to

radionuclide i (Sv or rem);
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DCFext,i,nside = external DCF for radionuclide i from the nth side of the source

([Sv/h]/[Bq/g] or [rem/h]/[pCi/g]); and

nside = n’th side of the source (unitless).

The source concentration, Ci,v, varies among different scenarios. It can be either Ci,scrap
or Ci,by-product. Tables 2.2–2.5 list the radiation sources considered for the external pathway in

different scenarios.

3.8  SURFACE CONTAMINATION METHODOLOGY

Radiation exposure from surface-contaminated materials is assessed for the reuse
scenarios. The inhalation, ingestion, and external exposure pathways are considered. The
radiation source is assumed to be inside a room; consequently, the air concentrations of
radionuclides are affected by the room ventilation system.

3.8.1  Inhalation Pathway

The inhalation dose from surface contamination, which is calculated by using an
emission rate (h–1) (Healy 1971), accounts for dilution of the air concentration by the ventilation
system. The effective dose equivalent is calculated as follows:

,)(

,

kV/ WF
 

DCFEDRFPFIRERACCEDE

sidecay,

iingssi,i inh,

×××

×××××××=

(3.9)

where

Ci,s = concentration of radionuclide i on the surface (Bq/cm2 or pCi/cm2);

As = surface area of the source (cm2);

ER = emission rate (h–1);
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Ws = surface transfer fraction, i.e., fraction of contaminants available for

emission (unitless);

V = volume of the room (m3); and

k = ventilation rate (h–1).

The default value for the inhalation rate used in the code is 1.2 m3/h (ICRP 1975), and
that for the emission rate is 1 × 10-6/h (Healy 1971).

3.8.2  Ingestion Pathway

Ingestion of radionuclides that are the result of surface contamination is possible through
two exposure routes: (1) inhalation of air particulates larger than the respirable size and
(2) incidental ingestion of dust deposited on the hands. The incidental ingestion dose from
surface contamination is based on a surface ingestion rate. The ingestion dose is calculated as
follows:

( )

( )  ,WFDCFEDIGC kV/W
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(3.10)

where

CEDEing,i = committed effective dose equivalent from ingestion of

radionuclide i (Sv or rem);

DCFing,i = ingestion DCF for radionuclide i (Sv/Bq or rem/pCi); and

IGs = ingestion rate of removable surface contamination (cm2/h).

RESRAD-RECYCLE uses a default value of 1 cm2/h for the ingestion rate for surface
contamination scenarios.
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3.8.3  External Pathway

Each contaminated surface contributes to the external exposure. In RESRAD-RECYCLE,
multiple contaminated surfaces are modeled for the various sides of a contamination source.
Each contaminated side can be modeled as either a full or half disk. Like the radiation doses
calculated for the inhalation and ingestion pathways, the radiation dose calculated for the
external pathway is obtained by using external DCFs. An external DCF is calculated for each
contaminated surface and depends on the size of the radiation source and distance (i.e., parallel
and perpendicular) between the receptor and the contaminated surface being considered. In
addition to source geometry and exposure distance, RESRAD-RECYLE also takes into account
the potential attenuation of the radiation dose caused by shielding materials. The user can specify
the type of shielding material and its density and thickness for consideration when the external
dose is calculated.

The DCF for a contaminated surface is calculated by using the same methodology for a
contaminated volume and assuming a very small thickness (0.01 cm). The external exposure is
calculated with the following equation:

 FDCFEDCEDE idecayiextsiiext ,,,, ×××=  , (3.11)

where

EDEext,i = effective dose equivalent from external exposure to radionuclide i

(Sv or rem) and

DCFext,i = external DCF for radionuclide i ([Sv/h]/[Bq/cm2] or

[rem/h]/[pCi/cm2]).

3.9  COLLECTIVE-DOSE CALCULATION

The collective dose for both worker and end-use-product scenarios is calculated by
multiplying the individual dose that is representative of the population by the size of the
population, that is, by the number of exposed individuals. Two exposure times are used in
RESRAD-RECYCLE to estimate individual dose; one for the maximally exposed individual
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(MEI), to obtain the upper bound of the individual dose; and one for the representative individual
in the population, to obtain the collective dose. Depending on the scenario under consideration,
these two exposure times may differ.

For the consumer product scenarios, the number of exposed individuals is pertinent to the
assumption that 100% of the slag or ingot from the smelter is used to produce the specific
product modeled in the scenario. Therefore, when the slag or ingot distribution to the specific
product is less than 100%, the collective dose is further multiplied by the distribution percentage.

3.10  CUMULATIVE-DOSE CALCULATION

For end-use-product scenarios, the cumulative dose is the integrated population dose
delivered over the lifetime of the end-use products. The average activity concentration over the
lifetime of the product (see Section 3.3 for the average concentration calculation) is obtained,
and then it is multiplied by the lifetime of the product to get the integrated activity concentration
for use in the dose calculation. As for the collective-dose calculation, the distribution of the
smelting product (ingot or slag) in the various consumer products is taken into account when the
cumulative dose is calculated. For worker scenarios, the cumulative dose is equivalent to the
collective dose because the exposure duration is one year.

3.11  TRANSPORTATION METHODOLOGY

The transportation scenario addresses the external dose to members of the public that
reside along routes traveled by trucks loaded with radioactive scrap metal. For a truck loaded
with 20 t of scrap metal, external DCFs were derived in terms of dose per unit concentration per
unit population density per unit velocity per unit time traveled. The derivations of the DCFs were
based on the methodologies of RISKIND (Yuan et al. 1993) and RADTRAN (Neuhauser and
Kanipe 1993), computer codes designed specifically to estimate radiation doses that result from
the transport of radioactive materials. Because the transport of scrap metal would occur before
the smelting operations, concentrations of radionuclides in scrap metal are used directly without
adjustment by the partitioning factors. The collective dose is calculated as follows:

( ) ( ) throughputVelDF  DCFCCEDE popidecayiextsiiext 20//,,,, ××ρ×××=  , (3.12)
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where

CEDEext,i = collective effective dose equivalent from external exposure to

radionuclide i (person-Sv or person-rem);

DCFext,i = external DCF for radionuclide i (Sv/h per Bq/g per person/m2 or

rem/h per pCi/g per person/m2);

ρpop = population density (person/m2);

D = distance traveled by truck (km);

Vel = truck velocity (km/h); and

throughput = throughput or amount of metal recycled (t).

3.12  CANCER RISK CALCULATION

Potential cancer risks from radiation exposure are calculated in the RESRAD-RECYCLE
code by multiplying the radiation doses by latent cancer incidence risk factors. The default
values for the risk factors (0.0567/Sv for workers and 0.076/Sv for the public) correspond with
EPA recommendations (EPA 1991); however, the user has the option of entering other risk
factors for the risk calculation. These risk factors are accessible by selecting “risk parameters”
under the “file” menu item.

3.13  TOTAL IMPACT FROM RECYCLING

The total impact on workers from processing radioactive scrap metal is calculated by
summing the cumulative (collective) doses for all the selected worker scenarios. Similarly, the
total impact on end-product users is calculated by summing the collective and cumulative doses,
respectively, for all the selected product scenarios. Users are advised to select scenarios that are
applicable to the recycling process being considered. The estimated total impact on the



3-26

end-product users, however, is meaningful only when the sum of the distribution percentages
(for both ingot and slag, respectively) for all the considered products is 100%.

3.14  SCENARIO RANKINGS

After the calculations have been completed, the scenarios are ranked in descending order
according to individual, collective, or cumulative dose. A scenario in which an individual dose
ranks as 1, therefore, could potentially result in the highest MEI dose. These scenario rankings
are listed in the summary report generated by RESRAD-RECYCLE.

3.15  RELEASE-CRITERIA DERIVATION

The release criteria for scrap metal calculated by RESRAD-RECYCLE satisfy the given
dose limits set for individual and population exposures. In other words, scrap metal with
contamination levels less than the release criteria would not lead to individual and population
exposures greater than the set dose limits, once the scrap metal has been released for reuse or
recycle. The code allows the user to enter distinct dose limits for four groups of receptors: the
individual worker, the worker population, the individual member of the public, and the general
public. These dose limits can be accessed by selecting “risk parameters” under the “file” menu
item. The release criteria are calculated for each radionuclide and each scenario as follows:

 DoseCHL kiikki ,, /=  , (3.13)

where

Li,k = derived release criteria for radionuclide i and receptor k (Bq/g or

Bq/cm2 or pCi/g or pCi/cm2);

Dosei,k = estimated radiation dose for radionuclide i and receptor k (Sv or rem

for individual receptors and person-Sv or person-rem for collective
receptors); and

Hk = radiation dose limit for receptor k (Sv or rem for individual

receptors and person-Sv or person-rem for collective receptors.)
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The release criterion estimated for each end-product scenario is meaningful only when the
distribution percentage (slag or ingot) to that product is 100%.

3.16  PROBABILISTIC ANALYSIS

For a mathematical model, probabilistic analysis is the computation of statistical variance
in the output results that is induced by the variance in the input parameters. It is imortant to
quantify variance in the output results when performing an analysis in which parameters with
potentially differing values must be used and combined. In a probabilistic analysis, information
about distribution of the input parameters must be provided before distribution of the output
results can be calculated. In addition to analyzing the distribution of output results, this type of
analysis also determines the contributions to the variance in the output results by the variance in
the individual input parameters. Therefore, the probabilistic analysis can be used to help decide
whether resources should be expended to obtain additional information or data to reduce
variance in the input parameters.

The RESRAD-RECYCLE code is designed to perform probabilistic analysis to examine
the effects of input parameter variance on the potential radiation doses of various receptors. A
standard Monte Carlo method or modified Monte Carlo method, that is, Latin hypercube
sampling (LHS) (Iman and Shortencarier 1984), can be applied to generate differing sets of input
data. Each set of input data is used to generate one set of output data. The output data sets are
then analyzed and presented in a statistical format in terms of cumulative distribution of radiation
dose, average radiation dose, standard deviation of the radiation dose, minimum radiation dose,
and maximum radiation dose.

3.16.1  Distribution of Input Parameters

A set of input parameters can be selected for analysis through the code’s interface. Each
selected parameter must be assigned a probability distribution function and can be correlated
with other input parameters included in the analysis. Table 3.5 lists the distribution functions and
the pertinent parameters that characterize the distributions considered by the RESRAD-
RECYCLE code. Figure 3.3 shows graphs of various distribution functions.
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TABLE 3.5  Distribution Functions Considered by RESRAD-RECYCLE

Distribution
Functions Parameter Distribution Parameter Description

Normal Mean (µ) and standard deviation (σ) Cutoffs of the normal distribution are taken to
be ±3.09 σ from the mean.

Lognormal Minimum and maximum values The specified minimum and maximum values
are the logarithms of the cutoffs of the input
parameter. Normal distribution of the input
parameter is observed within the range of the
cutoffs.

Uniform Minimum and maximum values Equal probability within the specified range
on linear scale.

Loguniform Minimum and maximum values Equal probability within the specified range
on a logarithmic scale. The specified values
must be > 0.

Triangular Minimum value (a), peak value (b),
and maximum value (c)

Three cases are possible: a < b < c, a ≤ b < c,
or a < b ≤ c.

N o rm al D is trib u tio n L o g n o rm a l D is tr ib u tio n

U n ifo rm  D is trib u tio n L o g u n ifo rm  D is trib u tio n

T ria n g u la r D is trib u tio n

C S

FIGURE 3.3  Plots of Distribution Functions Available in
RESRAD-RECYCLE (PCDIST-L)



3-29

One input parameter can be correlated with another input parameter by specifying a
correlation factor. The larger the absolute value of the correlation factor, the stronger the
correlation between the input parameters.  A negative correlation indicates that while the value
of one parameter increases, the value of the other parameter decreases. Positive correlation
indicates the opposite trend. Correlation between the selected input parameters is handled in
RESRAD-RECYCLE with the rank correlation method, which is discussed in the following
section.

3.16.2  Sampling Method

Values for the input parameters are generated by the preprocessor of the RESRAD-
RECYCLE code, which is adapted from a computer code developed by Iman and Shortencarier
(1984). The interface screens of RESRAD-RECYCLE collect all of the information necessary
for generating various sets of input data, such as initial seed value for the random number
generator, number of observations, number of sampling repetitions, type of distribution,
characteristic parameters of the distribution, and correlation factors between input parameters.
The number of samples generated is the product of the number of observations, Nobs, and the
number of repetitions, Nrep.

The LHS method, a constrained sampling method developed by McKay et al. (1979),
divides the distribution range of each input parameter into Nobs nonoverlapping regions on the
basis of equal probability according to the distribution characteristics. One value in each region
is randomly selected with respect to the probability density over that region. After Nobs samples
of the input parameter have been selected, the process is repeated first for the second parameter
and then for the remainder of the selected parameters. The samples of the first parameter are
randomly grouped (equally likely combinations) with the samples of the second parameter. If no
correlation is observed, these Nobs pairs of data are combined with the samples from the next
parameter in a random manner. This technique of randomly grouping samples is repeated to
include all input parameters considered in the analysis. The result is Nobs sets of input data. The
sampling and grouping procedures are repeated Nrep times. Therefore, a total of Nrep × Nobs sets
of data are available for calculating dose.

LHS is a constrained sampling method because one distinct value is selected from each
region of equal probability. However, if the number of observations is set to one, the entire
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distribution range is not partitioned; therefore, a standard Monte Carlo sampling method is
performed.

The random grouping among parameters is not applied if the user chooses to correlate the
parameters. Because data correlation is difficult and complicated to implement, correlation is
based on the ranks of the data. The generated data of each parameter are ranked by their values.
The parameter with the smallest value is assigned a rank of 1; the one with the largest value is
assigned a rank of Nobs. Grouping of data among input parameters is implemented according to
some specific orders, which then would lead to a rank correlation factor close to the specified
value.

The rank correlation method is easy to implement and especially useful for mathematical
models in which the relationships between input parameters and output results are nonlinear.
Further information on the rank correlation method and its implementation in the RESRAD-
RECYCLE code can be found in Davenport and Iman (1982).

The random grouping of input parameters can lead to undesired correlations. Such
correlations can be reduced by implementing the restricted-pairing technique among the
sampling data, as discussed in the rank correlation method, or by increasing the number of
observations for data sampling. To use the restricted sampling technique, Nobs must be greater
than the number of selected parameters (K). According to Iman and Helton (1985), good results
can be obtained with Nobs ≥ (4/3) K; however, this is not an absolute rule. If the model is
inexpensive to run, Nobs could be larger, e.g., between 2 and 5 K.

3.16.3  Cumulative Probability of Potential Doses

The RESRAD-RECYCLE code calculates the cumulative probabilities of the individual,
collective, and cumulative doses for all radionuclides. The cumulative probability at a certain
dose value is a measure of the likelihood of which dose value would not be exceeded.
Calculation results, presented in tabular form, list radiation doses that correspond to specified
cumulative probabilities. The increment of the specified cumulative probabilities is 0.025, or
2.5%. Thus, 40 (100/2.5) dose values are presented regardless of the sampling size. In addition to
the tabular form, graphical presentation is provided.
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3.16.4  Correlation between Radiation Doses and Input Parameters

The linear regression method is used to evaluate the correlation between the resultant
doses and the input parameters selected for probabilistic analysis. A linear relationship is
assumed between the resultant dose and the input parameters. The standardized regression
coefficient is calculated with the standardized values (i.e., [actual value-mean]/[standard
deviation]) of the input parameters and the total dose (Iman et al. 1985). These coefficients
provide a direct measure of the importance of each input parameter to the total dose, regardless
of the units being used for the input parameters.

The regression coefficients of the input parameters are ranked to determine the relative
influence of the input parameters on the results. The correlation ranking of the input parameters
is based on the absolute value of the standardized regression coefficients; a rank of 1 is assigned
to the variable with the highest value. Thus, a parameter with a correlation rank of 1 has the
strongest influence on the total dose. The correlation rank is set to 0 if the regression coefficient
is 0 or if the resultant correlation matrix is singular.

The RESRAD-RECYCLE code also calculates the coefficient of determination of the
regression analysis. The coefficient of determination is defined as the ratio between the variation
in the resultant dose caused by regression in the input parameters and the total variation in the
resultant doses. Therefore, it provides a measure of the percentage of variation in the dose
explained by regression of the input parameters and varies between 0 and 1. The coefficient of
determination provides a convenient way to measure the adequacy of the regression model.
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4  USER’S GUIDE

4.1  INSTALLING RESRAD-RECYCLE

RESRAD-RECYCLE, available on two 1.44-megabyte (MB), 3.5-in. diskettes, is a self-
installing program in the Windows environment and requires a minimum of a Microsoft
Windows 3.1 operating system, an 80386 processor-based computer with a math coprocessor,
and 3 MB of hard disk space. The code can be installed by inserting the diskette into the
appropriate floppy disk drive (a: or b:). For the Windows 3.1 operating system, the File menu
must be chosen and the Run option selected from the Program Manager or File Manager. For the
Windows 95 or later operating system, Start must be selected, then the Run option chosen; or,
the My Computer icon must be selected, then the appropriate floppy disk drive chosen. The
SETUP.EXE program can be run from the drive that contains the RESRAD-RECYCLE diskette
(e.g., a:SETUP). The SETUP program displays a screen that shows the status of the installation.

When the installation is complete in the Windows 3.1 operating system, a new RESRAD-
RECYCLE icon is placed in the RESRAD Group, which is created if not present, under the
Program Manager. For the Windows 95 or later operating system, when the installation is
complete, a new RESRAD-RECYCLE option is placed in the RESRAD program group under
the programs list; the RESRAD program group is created if not present.

The code is fully Windows compatible and allows data entry and scenario selection, text
and graphical results display, and file opening and saving in a user-friendly environment.

4.2  RUNNING RESRAD-RECYCLE

Double-clicking the RESRAD-RECYCLE icon (option) starts the program. The first
screen provides simple information about the code. The next screen is the code’s main graphical
screen.

The main graphical screen (Figure 4.1) displays a modular diagram of the various steps
that are modeled in the recycling of radioactive scrap metal. The input box in the upper left
corner contains the case title. Clicking any module icon in the graphical main screen opens
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 FIGURE 4.1  RESRAD-RECYCLE Main Graphical Screen

Add the current parameter to the list for 
uncertainty analysis. View the latest text report. View the graphical results of uncertainty analysis.

Graphic displaying the recycling processes 
considered in RESRAD-RECYCLE.
Graphic also allows access to the scenario
data and indicates which processes are active.View the uncertainty analysis summary form.

View the deterministic graphical results.

Reset all parameters to defaults.

Open a file.

Save data to the current file.

Calculate the dose for the selected scenarios.

Save the current form.

Cancel the current form.

Windows corresponding to the
various recycling processes. 
These windows can also be
used to access the scenario
input parameters.
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another screen for entering data, selecting a scenario, or opening associated input. The scrap
inventory module allows the user to select radionuclides and to specify activity concentrations
and throughput for scrap metal. The other modules, which correspond to the various recycling
steps, from initial transport of scrap metal to the use of end products, permit the user to select
various scenarios for dose analysis and to modify the input parameters used in the analysis. The
scrap smelting module also allows the user to specify mass and radionuclide partitioning factors
for the smelting process.

The menu bar at the top of the main screen contains five options: File for managing files,
Scenarios for selecting recycling steps for consideration, Form Options for handling data input
forms, View for viewing calculation results, and Help for accessing on-line help. These items and
the associated options can be activated by clicking the left mouse button when the option is
highlighted, or by pressing both the Alt key and the underlined letter on the keyboard. Table 4.1
provides a complete list of the RESRAD-RECYCLE menu options.

4.2.1  Using the Button Bar

RESRAD-RECYCLE includes a button bar, located below the menu bar at the top of the
screen, that contains several buttons for the most frequently used menu options. Clicking the
button has the same effect as choosing the corresponding option from the menu bar. Choosing
Button Prompts from the View menu option displays prompts that briefly explain the function of
each button as the mouse pointer moves over the button. The function of each button is explained
in Figure 4.1.

4.2.2  Entering the Radionuclide Inventory

The first module of the RESRAD-RECYCLE main graphical screen is “Scrap
Inventory.” Clicking this module opens the inventory input window (Figure 4.2). This window
can also be accessed by double-clicking the Scrap Inventory button bar at the bottom of the main
screen.

The Scrap Inventory Input window contains data concerning parameters that apply to the
overall scrap inventory, such as scrap metal type, throughput of scrap metal to be recycled, and
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TABLE 4.1  RESRAD-RECYCLE Main Menu Optionsa

Item Option Access Key Function

File New Resets all input parameters to the default value.
Open Ctrl-O Opens a new data file.
Save Ctrl-S Saves the current data to the current data file.
Save As Ctrl-A Allows the current data to be saved to a new data file.
Calculate Dose Ctrl-R Calculates doses and risks for the current case.
Risk Parameters Allows dose limit and risk parameters to be modified.
Exit Exits the RESRAD-RECYCLE program.

Scenarios Edit Brings up the scenario input window for editing.
On/Off Toggles on or off the recycling step.
Select All Scenarios
Deselect All Scenarios

Selects all exposure scenarios for analysis.
Deselects all exposure scenarios included in the current
case.

Form Options Save Current Form Ctrl-K (F10) Accepts the values of and closes the current input form.
Cancel Current Form Ctrl-U (Esc) Cancels changes made and closes the current input form.
Uncertainty Analysis F8 Adds the current parameters to the list for uncertainty

analysis.

View Text Output Allows text reports to be viewed.
Graphical Output Allows graphical output to be viewed.
Message Log Ctrl-E Displays the latest diagnostic information from the

calculations.
Uncertainty Summary Ctrl-F8 Toggles the visibility of the uncertainty analysis

summary form.
Button Prompts Toggles the mouse cursor button prompts.

Help General Help F1 Provides overall help for navigating through the code.
Context Sensitive Help F2 Provides help for the current parameter or scenario.
Help for the Current Form Provides help for the current process module form.
Worker Scenarios Provides overall help for all worker scenarios.
Consumer Scenarios Provides overall help for all end-product scenarios.
About RESRAD-RECYCLE F3 Shows the “about” form for RESRAD-RECYCLE.

a The options listed under each menu item can be selected by pressing the mouse button while the option is highlighted or
by entering the access key listed in this table.

the radionuclides present in the scrap metal. The scrap metal type can be selected by clicking the
dropdown box and selecting the appropriate material type. When the material type is changed,
the default parameter values are loaded for that material type. In addition, the user can click the
Adjust Population for Throughput button. This option allows the code to change the default
exposure duration (for worker scenarios) and the number of people exposed (end-product
scenarios) to reflect the input throughput value (see the discussion on Throughput Considerations
in Section 3.6). The user can also apply an initial decay time and a dilution fraction for all
selected scenarios by entering the desired values and clicking the corresponding Reset buttons.
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FIGURE 4.2  RESRAD-RECYCLE Inventory Input Window
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To add a radionuclide in the Scrap Inventory window, the user can select the desired
radionuclide from the Nuclide List and press the Add Nuclide button. The cursor control keys can
be used to scroll down or up the list. Pressing a letter moves the cursor to that portion of the
alphabetized Nuclide List. Pressing the Enter key adds the highlighted radionuclide to the scrap
inventory list. Double-clicking a radionuclide with the mouse also adds the radionuclide to the
scrap inventory list. Clicking the Delete Nuclide button on the Inventory window removes the
highlighted radionuclide from the inventory list. When a radionuclide is selected, an asterisk
appears by its symbol in the Nuclide List.

The cursor control arrow keys and the Enter key can be used to move through the
Nuclide List included in the selected inventory. The nuclide concentration can be specified by
typing in the concentration for the highlighted radionuclide in the field provided. Clicking a
selected radionuclide highlights that radionuclide. The user has the option of specifying either
the volume concentration (in pCi/g or Bq/g) or the surface concentration (in pCi/cm2 or Bq/cm2)
by clicking the corresponding unit option buttons, located to the right of the Nuclide
Concentration value (see Figure 4.2). In the reuse scenarios, surface contamination is assumed.
Clicking the Delete Nuclide button removes the currently highlighted radionuclide from the
inventory. The Scrap Inventory screen can be closed by clicking the Save button on the button
bar, pressing the F10 key, or by clicking the Done button on the scrap inventory screen.
Changes made to the scrap inventory window cannot be canceled. In addition, a case
calculation cannot be performed unless at least one radionuclide is selected.

4.2.3  Selecting Scenarios

Clicking a recycling step module in the main screen displays a list of representative
scenarios for that particular step, as shown in Figure 4.3 for the scrap smelting step. The scenario
screen can also be accessed by double-clicking on the main screen or by double-clicking the
appropriate button for the module, which is also located at the bottom of the main screen.
Scenarios are selected by checking the box next to the scenario name. A box can be “checked”
by using the mouse, the Enter key, or the space bar. The cursor can be moved among the
scenarios with the Tab key or the cursor movement (arrow) keys.
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FIGURE 4.3  RESRAD-RECYCLE Module for the Scrap Smelting Step

Activating a
scenario and
clicking on its
parameters
button displays
the parameters
for that scenario.

This button allows the source geometry, material,
shielding, etc., to be modified.

Each recycling step contains several receptors (scenarios). Pressing the
button for any step displays the scenarios for that step.



4-8

4.2.4  Editing Partitioning Factors
The mass and radionuclide partitioning factors input window (see Figure 4.4) is displayed

by clicking the Partition Factors command button in the Scrap Smelting panel. The access key
for this button is “P.” The default values are displayed for the mass and radionuclide partitioning
factors, and the user can enter various values. Clicking the Normalize button under the
radionuclide partitioning factors causes the partitioning factors to be normalized when the total,
which appears at the bottom, is not exactly 100%. The partitioning factors input window can be
closed by pressing Ok.

4.2.5  Editing Scenarios

Clicking the parameter button next to a scenario opens the input form, which lists the
modeling parameters for that scenario (see Figure 4.3; the panel is labeled “Scrap Smelting:
Smelter Yard Worker”). The parameter button can be clicked by pressing the left mouse button
or by pressing the Alt key and the underlined letter (access key) in the scenario name
simultaneously. The input form displays the default values for all parameters, which can be
modified by the user. Moving about the input fields in the input form can be accomplished by
using the mouse, the Tab key, the Enter key, or the underlined access keys. The cursor control
keys move the cursor within an input field, but not between input fields.

Parameter values for a given scenario can be saved by pressing the F10 key, which also
closes the displayed input form. The Save Current Form option under the Form Option menu on
the menu bar also can be used to save any changes and close the input form. The corresponding
button on the button bar also provides the same function. The ESC key can be used to close a
window and discard any changes that have been made. The Cancel Current Form option under
the Form Options menu on the menu bar, as well as the corresponding button on the button bar,
also closes a form without saving any changes.
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FIGURE 4.4  Input Window for Partitioning Factors in RESRAD-RECYCLE
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4.2.6  Getting Help

RESRAD-RECYCLE provides on-line help, which is accessed through the Help menu on
the main window. The following options are available:

• General Help provides overall help for navigating the code.

• Context Sensitive Help provides help for the current parameter or scenario.

• Help for the Current Form provides help for the current input window.

• Worker Scenarios provides an overall description of the worker scenarios.

• Consumer Scenarios provides an overall description of the end-product
scenarios.

4.3  ENTERING UNCERTAINTY ANALYSIS PARAMETERS

Uncertainty analysis can be performed by examining the distribution of any scenario
input parameter. An input parameter can be selected for examination by pressing the F8 key, by
selecting the Uncertainty Analysis option under the Form Options menu on the menu bar, or by
selecting the corresponding button on the button bar while the parameter is highlighted. After a
parameter is selected, the Uncertainty Analysis Summary window is displayed on the screen or
can be selected for review by clicking the corresponding window icon at the bottom of the main
screen.

The Uncertainty Analysis Summary window, shown in Figure 4.5, allows the user to
specify the distribution format as well as the characterization parameters for each selected
parameter. The correlation between any two selected parameters can also be specified. In
addition, the Random Seed Value, the Number of Observations, and the Number of Repetitions
for data sampling can also be specified.
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4.3.1  Setting Distributions for Parameters

Once a parameter is selected for uncertainty analysis, it is included in the Uncertainty
Analysis Summary window (Figure 4.5). The lower half of this window provides descriptions of
the selected variables, names of the variables used in the RESRAD-RECYCLE code, and their
distribution characteristics. The distribution format of a variable, or parameter, can be changed
by highlighting the corresponding cell under the Distribution column and selecting the
distribution format (normal, lognormal, uniform, loguniform, or triangular) by scrolling down
the input field or by checking the representative distribution graphics, then pressing Enter. The
input field and the distribution graphics are displayed in the middle of the window directly above
the distribution description. After the distribution format has been specified, the user can enter
the corresponding characteristic parameters, such as the maximum and minimum, by
highlighting the corresponding cell and entering the appropriate value in the input field.

RESRAD-RECYCLE supports five distribution formats — normal, lognormal, uniform,
loguniform, and triangular. For all except the normal distribution format, the characterizing
parameters are the minimum and maximum values. Normal distribution is characterized by the
mean and standard deviation. In addition to being characterized by the minimum and maximum
values, the triangular distribution is also characterized by the peak value of the distribution.

4.3.2  Setting Correlation between Parameters

Two parameters can be correlated by selecting the first parameter from the lower portion
of the summary window, clicking the Correlate button (or using the access key Alt-E), selecting
the second parameter (also from the lower portion of the summary window), and clicking the
Correlate button. The two parameters appear in the Correlation panel — a summary table — at
the upper right of the screen. Moving the cursor to the Factor column of the correlation summary
table allows the user to enter the correlation factor from the input field.

4.3.3  Removing Parameters from Uncertainty Analysis

The Delete button in the Uncertainty Analysis Summary window (Figure 4.5) can be used
to remove information entered for uncertainty analysis. When the cursor is placed in the
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FIGURE 4.5  RESRAD-RECYCLE Uncertainty Analysis Summary Window
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Correlation panel, the Delete button removes the correlation that the cursor points to. If the input
cursor is in the lower portion of the window, where the parameter distribution information is
summarized, the Delete button removes the corresponding parameter from the uncertainty
analysis, including any correlation that involves that parameter. Removing all listed parameters
suppresses the uncertainty analysis. Setting the number of samples (i.e., the product of the
number of observations and the number of repetitions) to 0 also suppresses the uncertainty
analysis.

4.3.4  Saving and Retrieving Uncertainty Analysis Information

Pressing the Save or Cancel button closes the Uncertainty Analysis Summary window,
and normal RESRAD-RECYCLE input data editing can be resumed. The Uncertainty Analysis
Summary window must be closed before normal editing can be continued. The window can be
displayed again by selecting another parameter for uncertainty analysis or by double-clicking the
Uncertainty Analysis Summary window icon at the bottom of the main screen.

The visibility of the icon of the Uncertainty Analysis Summary window can be toggled
on/off by checking the Uncertainty Summary option under the View menu on the menu bar. The
corresponding button on the button bar and the access key Ctrl-F8 also perform the same
function.

4.4  SAVING INPUT DATA FILES

Data can be saved on a disk file by using the Save or Save As option under the File menu.
The Save option saves the data in the current data file, whereas Save As allows the data to be
saved in a new file. A file can be retrieved from the disk by using the Open option under the File
menu. The New option under the File menu resets all parameters to the default values.

4.5  PERFORMING CALCULATIONS

The current data can be used to perform dose and risk calculations by choosing the
Calculate Dose option under the File menu. If the current data have not been saved, the user is
prompted to save them in a disk file before the calculation. Dose and risk calculations can also be



4-14

performed by clicking the corresponding button on the button bar. A message window appears
on the screen to indicate the progress of the calculations.

4.6  VIEWING RESULTS

Once the calculations have been completed, the report viewer displays the text of the
RECYCLE.REP file. The report viewer contains its own menu bar and menu options that control
the viewing activities. The function of the main menu (for the main screen) can be resumed by
clicking any window other than the report viewer, or by closing the report viewer. The report
viewer can be closed by selecting the Exit Viewer option from the File menu of the report viewer
or by pressing the Close button, which is at the far right top of the viewer window.

The report viewer can be opened at any time by selecting the desired report from the Text
Output option from the View menu of the main screen. In addition to the RECYCLE.REP report,
which provides calculated doses for each selected scenario, four other reports are also generated
in each calculation: (1) DCF_EXT.REP, which provides calculated external radiation dose
conversion factors; (2) LIMIT.REP, which provides derived radionuclide concentration levels for
scrap metal that will meet a given dose limit; (3) RISK.REP, which provides calculated excess
cancer risks for each selected scenario; and (4) MRECYLE.REP, which provides the results of
the uncertainty analysis.

To view a specific page of a report, the user can type in a page number in the Page input
field or scroll through the page list to select the specific page. Another way to view a specific
page is to tab the cursor into the text of the report and use the cursor control keys to move to the
desired page. The cursor control keys include the Next Page and Previous Page buttons on the
viewer and the Page Up and Page Down keys on the keyboard.

The report viewer can also be used to view any ASCII (American Standard Code for
Information Interchange) file. In the main screen, this can be executed by selecting the Any File
suboption from the Text Output option of the View menu on the menu bar. While in the report
viewer, this can be executed by selecting the Another File option from the View menu.
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4.6.1  Saving and Printing a Report

The File menu of the report viewer provides options for selecting and setting up a printer,
printing the report, and saving the report in a file. Selecting the Print option will open a dialog
window in which a page range can be entered for printing. The selected pages are sent to the
Windows printer. The default printer and page setup can be changed by choosing the Printer
Setup option. Clicking the Print button on the button bar of the report viewer also prints the
report. Clicking this button prints the entire report, unless a page range had been entered the last
time the Print option was selected from the File menu; in the latter case, the pages are printed
within the previously defined range.

The Font option on the report viewer allows the report to be displayed and printed in any
font installed on the system. The default font is the MS Line Draw font, if installed. The Size
option is used to specify the size of the font used for displaying and printing the report. The
paper layout shown next to the Size option indicates the current orientation of the paper, either
portrait or landscape; the number next to this paper layout image indicates the printing width, in
inches, of the current report page if the current font and the current font size are used.

The Save option on the File menu saves the entire report in a text file. Selecting this
option will open a file selection window that allows the disk drive, directory, and file name of
the new file to be specified.

4.6.2  Copying Reports to Other Windows Applications

The Copy option of the Edit menu in the report viewer allows the user to copy
highlighted text onto the Windows clipboard for pasting into other Windows applications. Text
can be selected by the standard Windows methods: by using the mouse to drag across the text
with the left mouse button pressed, or by using the cursor control keys across the text while
pressing Shift. In addition, the Select All option on the Edit menu can be used to select the entire
text of the current page. The Copy button on the report viewer button bar also allows copying of
the selected text onto the Windows clipboard.
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4.6.3  Viewing Graphics

The RESRAD-RECYCLE code can plot the estimated radiation doses and dose fractions
attributed to various pathways, radionuclides, and scenarios. The graphics interface form, shown
in Figure 4.6 is designed to facilitate specifications for graphics display. The graphic interface
can be activated by selecting the Graphic Output option from the View menu on the main screen,
then selecting the appropriate calculation results (deterministic or uncertainty) for display. The
boxes at the lower left of the interface window can be used to check the category (pathway,
radionuclide, or scenario) to be used in comparing the doses or fraction of doses. The other input
fields are used to select the component from each of the other categories to which the doses
contribute. For example, if the user has indicated that radiation doses should be compared by
pathways, a specific radionuclide and scenario must be selected so that the radiation doses from
that radionuclide and scenario can be compared by pathways.

The RESRAD-RECYCLE graphics program draws either bar or pie charts. Clicking the
Dose button indicates that bar charts should be provided, whereas the Fraction button produces
pie charts. For bar charts, one or two of the check boxes at the lower left corner of the interface
can be selected; for pie charts, only one check box can be selected.

Clicking the Graph button on the interface form opens a new window that displays
graphic results based on the current selections. The number of new windows that can be opened
at a time is only limited by the system’s resources. The two buttons on the new window are used
to print the graphics and to close the new window.
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FIGURE 4.6  RESRAD-RECYCLE Graphics Interface Form
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5  BENCHMARKING AND VALIDATION

Data from a study prepared by S. Cohen and Associates (1995) for the EPA were
compared with the results from RESRAD-RECYCLE Version 2.2 for two scenarios: baghouse
processor and slag worker. All input parameters and geometries used in the EPA study were
applied in RESRAD-RECYCLE. Table 5.1 lists the assumptions used in the EPA scenarios.
Fifteen radionuclides were included in the comparison. The concentration of each radionuclide
was set to 1 pCi/g. Table 5.2 gives the EPA radionuclide partitioning factors that were used in
these benchmark calculations in place of the default values of RESRAD-RECYCLE.

A comparison of the results indicated good agreement between the RESRAD-RECYCLE
and EPA values (S. Cohen and Associates 1995). The RESRAD-RECYCLE code did not require
any modification because all of the parameters used in the dose evaluations are input variables,
and any desired values can be used. The EPA model, however, used differing exposure durations
for the ingestion dose and for the inhalation and external doses in the baghouse scenario. It was
unclear why the EPA used two exposure durations in its model. RESRAD-RECYCLE uses a
single exposure duration for all pathways; therefore, two runs, with differing exposure durations,
were needed to duplicate the EPA baghouse scenario.

Tables 5.3 and 5.4 give the benchmark results for the baghouse processor and slag worker
scenarios, respectively. Results for the relatively short-lived radionuclides, including cobalt-60,
cesium-134, manganese-54, and ruthenium-106, in the baghouse processor scenario showed
higher deviations than for the other radionuclides. These results occurred because RESRAD-
RECYCLE applies a decay factor to account for activity decay over a period of one year (see
Table 3.1). Removing this factor led to better agreement with EPA values. For example,
ruthenium-106 has an average decay factor of 0.724 (from Table 3.1). Dividing the total
RESRAD-RECYCLE dose of 2.2 × 10–3 mrem/yr by this factor yields a value of
3.0 × 10–3 mrem/yr, which is essentially equal to the EPA value shown in Table 5.3. In addition
to the decay factors, the minor discrepancies between the RESRAD-RECYCLE results and the
EPA values occurred because different external radiation methodologies were used.

In general, the results are in good agreement. The deviation between the two models is
within 30%, which can be attributed to the application of the average decay factor in RESRAD-
RECYCLE and the different external exposure model applied in the code. The EPA study
applies predetermined external DCFs derived with the Microshield computer code.
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TABLE 5.1  Assumptions for the Baghouse Processor and Slag Worker Scenario
Benchmarking Comparisonsa

Parameter Baghouse Processor Slag Worker

Inhalation rate (m3/h) 0.91 0.91
Ingestion rate (g/h) 0.06 0.06
Dilution fraction 1 1
Respirable fraction 1 1
Dust loading (g/m3) 0.05 0.005
Respiratory protection factor 0.125 1
Exposure duration (h) 49 (1,750 for ingestion dose) 1,750
Slag mass partitioning (%) NAb 5.5%
Baghouse mass partitioning (%) 1 NA
Source radius (cm) 200 185
Source thickness (cm) 61 153
Source density (g/cm3) 0.00137 1.7
Receptor distance (cm) 10 150
Source shape Two full cylinders One half cylinder
Source material Water Aluminum

a The external geometry in the EPA study was modeled as two rectangles for the
baghouse scenario and as half sphere for the slag worker. Because RESRAD-
RECYCLE uses cylindrical geometry, the external source is modified for use in the
code, thus keeping the volume constant.

b NA = not applicable.
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TABLE 5.2  Benchmark Radionuclide
Partitioning Factors

Partitioning Factor (%)

Radionuclide Ingot Baghouse Slag

Am-241 1 1 100
Co-60 100 1 1
Cs-134 1 100 25
Cs-137 1 100 25
Mn-54 1 1 100
Ni-63 100 1 1
Pu-239 1 1 100
Pu-241 1 1 100
Ra-226 1 1 100
Ra-228 1 1 100
Ru-106 100 1 1
Sr-90 1 1 100
Tc-99 1 1 100
U-235 1 1 100
U-238 1 1 100

Source: S. Cohen and Associates (1995).
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TABLE 5.3  Benchmark Results for the Baghouse Processor Scenario

Doses (mrem/yr)

RESRAD-RECYCLE

Radionuclide Ingestiona Inhalation External Total
EPA

Totalb
Ratio

RESRAD/EPA

Am-241 3.8E-01 1.2E-01 1.5E-05 5.1E-01 5.1E-01 1.0
Co-60 2.7E-03 5.7E-05 7.9E-04 3.5E-03 3.8E-03 0.9
Cs-134 6.5E-01 1.1E-03 4.6E-02 7.0E-01 8.3E-01 0.8
Cs-137 5.2E-01 8.8E-04 2.0E-02 5.4E-01 5.5E-01 1.0
Mn-54 2.0E-04 1.3E-06 2.0E-04 4.0E-04 6.2E-04 0.6
Ni-63 6.0E-05 1.8E-06 0.0E+00 6.2E-05 6.2E-05 1.0
Pu-239 3.7E-01 1.2E-01 1.4E-06 4.9E-01 4.9E-01 1.0
Pu-241 7.0E-03 2.2E-03 1.9E-09 9.2E-03 9.5E-03 1.0
Ra-226 1.4E-01 2.4E-03 5.9E-04 1.4E-01 1.4E-01 1.0
Ra-228 1.4E-01 1.3E-03 3.1E-04 1.4E-01 1.5E-01 1.0
Ru-106 2.1E-03 9.6E-05 5.4E-05 2.2E-03 3.1E-03 0.7
Sr-90 1.6E-02 3.6E-04 1.2E-05 1.6E-02 1.7E-02 1.0
Tc-99 1.5E-04 2.3E-06 7.7E-08 1.6E-04 1.6E-04 1.0
U-235 2.8E-02 3.4E-02 5.6E-05 6.2E-02 6.2E-02 1.0
U-238 2.8E-02 3.3E-02 1.1E-05 6.1E-02 6.1E-02 1.0

Total 2.3E+00 3.2E-01 6.8E-02 2.7E+00 2.8E+00 0.9

a The ingestion dose is calculated with an exposure duration of 1,750 h/yr; the other pathways
are calculated with an exposure duration of 49 h/yr.

b Source: S. Cohen and Associates (1995).



5-5

TABLE 5.4  Benchmark Results for the Slag Worker Scenario

Dose (mrem/yr)

RESRAD-RECYCLE

Radionuclide Ingestiona Inhalation External Total
EPA

Totalb
Ratio

RESRAD/EPA

Am-241 7.0E+00 6.4E+01 2.5E-02 7.1E+01 7.1E+01 1.0
Co-60 4.8E-04 3.0E-04 1.0E-01 1.0E-01 7.9E-02 1.3
Cs-134 3.0E-02 1.4E-03 1.4E+00 1.4E+00 1.2E+00 1.2
Cs-137 2.4E-02 1.1E-03 5.7E-01 5.9E-01 4.7E-01 1.3
Mn-54 3.6E-03 6.6E-04 2.4E+00 2.4E+00 2.5E+00 0.9
Ni-63 1.1E-05 9.1E-06 0.0E+00 2.0E-05 2.0E-05 1.0
Pu-239 6.8E+00 6.2E+01 2.0E-04 6.9E+01 6.9E+01 1.0
Pu-241 1.3E-01 1.2E+00 1.2E-05 1.3E+00 1.3E+00 1.0
Ra-226 2.5E+00 1.2E+00 7.5E+00 1.1E+01 9.0E+00 1.3
Ra-228 2.6E+00 6.9E-01 3.8E+00 7.1E+00 6.9E+00 1.0
Ru-106 3.8E-04 5.0E-04 6.3E-03 7.2E-03 7.3E-03 1.0
Sr-90 2.9E-01 1.9E-01 1.6E-02 4.9E-01 4.8E-01 1.0
Tc-99 2.8E-03 1.2E-03 2.3E-04 4.2E-03 4.0E-03 1.1
U-235 5.1E-01 1.8E+01 5.0E-01 1.9E+01 1.9E+01 1.0
U-238 5.1E-01 1.7E+01 8.9E-02 1.8E+01 1.8E+01 1.0

Total 2.0E+01 1.6E+02 1.6E+01 2.0E+02 2.0E+02 1.0

a The ingestion dose is calculated with an exposure duration of 1,750 h/yr; the other pathways are
calculated with an exposure duration of 49 h/yr.

b Source: S. Cohen and Associates (1995).
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